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How to Use This Workbook

Hey BFF!l I'm so glad you decided to get the workbook! | put this together for you so
that you have the entire 5 Day Website Challenge at your fingertips - and so that you
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don't have to scroll through videos over and over to follow along! Here are some tips
to help you make the most of the workbook:

° Use the clickable table of contents. When you click on any item in the table of
contents, it’ll send you right to that section of the workbook. You can also open up the
Outline (tab on the left-side) to have the entire table of contents open while you scroll.

° Use Cirl+F to search for any keyword so that you don’t have to scroll the
workbook to find what you're looking for.

° Printing is NOT recommended. This guide is nearly 300 pages and includes some
animated GIFs for demonstration, so unless you have unlimited paper and toner, |
recommend only printing the frackers at the end of the workbook. Totally up to you
(just know that I've got lots of clickable links in this doc to make things super easy for
youl)

) Use the screenshots. For every setting | walk you through in the 5 Day Website
Challenge videos, I've pasted screenshots for you here so that you can look at the
picture and make sure your settings look the same.

° Add your own notes. You made a copy of this document - it’s yours to edit, add
comments, highlight, etc. You can download a new, fresh copy any you want so
don’t worry about accidentally deleting anything.

° Save time by watching the videos at 2x speed and following along with the
workbook.

How to get help:

° Join the 5 Day Website Challenge Group. That's where | answer questions about
the Challenge (and there are no dumb questions!) There are thousands of other
people in there who have taken the Challenge who can help you out too!

° Check out the FAQ page. There are questions | get asked A LOT, and I've put
them all on this page: https://shannonmattern.com/FAQ. Check here first, then ask in
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the Group if you can't find an answer.
Where to learn more about getting traffic + growing your business:

| have a podcast called Pep Talks for Side Hustlers where | share marketing strategies,
side hustle motivation and interview other successful business owners to get their best
business tips + advice for you so that you can create the freedom, flexibility and
financial independence you desire. Here’s where you can listen + subscribe:

Apple Podcasts | Google Podcasts | Google Play | iHeartRadio | Stitcher | Spotify

Finally, when you're done with your website, sign up for my free training on “*How to
Market Yourself Online (without ads, algorithms or a big audience on social media)” so
that you know exactly what to do next after you've built your website to get
high-quality traffic.

And if you're a web designer (or wanna start building websites for other people) sign
up for my free training on how to get your first web design client here.

That's it! It's time to get started! Can’t wait to see what you create!

Wgﬁm
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Day 1 - Foundation

1.0 - The Big Picture

In Day 1 you're gonna get your domain + hosting, install WordPress and learn your way
around the back-end of your site, install plugins and set up a business email address.
We also how to overcome any roadblocks that get in your way as you DIY your
website!

1.1 - Shopping List

Just like any DIY project, you're gonna need a few supplies to get the job done! In this
video I'm gonna break down exactly what you need and give you my
recommendations for the best tools for DIYing your website the right way from the
start!

My recommendations:

Domain + Hosting: Bluehost*
Theme/Page Builder: Elementor Pro*
Graphics: Canva*

Email List: ConvertKit*

Optional Site-in-a-Snap Template Pack

You can purchase these tools as you go throughout the Challenge.

Bluehost: Depending on your budget, you can lock in 3 years at $2.95 a month or one
year at $4.95/month.

1 Year: $59.40 ($4.95/month)
3 Years: $106.20 ($2.95/month)

Domain name included for one year, renews at $18.17 annually

Renews after your promo period at $7.99/month
30 Day Moneyback Guarantee
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° Free SSL (automatically set up)

W chat Ocall -  ZLogin = USD ~

Hosting - Domalns Professional Services - Emall Affillates

Together, Online.

We're here to help your small business or remote work team adapt to the challenges of COVID-19

Elementor Pro: $49 for a one-year license subscription that includes extra features,
plugin updates and support. 30-Day Moneyback Guarantee.
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@ Features = Pricing Respurces Help Center + Blog Experts My Account | GET STARTED :1

PERSONAL

‘49, '99,. 199,

For 1 Site For 3 Sites For 1,000 Sites
204+ Widgeta a0+ Widgats a0 Widgets
300+ Pro Templates 300+ Pro Templates 300+ Pro Templates
Theme Buitder Tharme Builder Theme Bullder
WooCommerce Bulicer ‘WooCommerce Bullder WocCommerce Buildsr
Popup Builder Popup Builder Popup Builder
Support for 1 Year Support for 1 Year Support for T Year
Updates for 1 Year Updatas for 1 Year Updates for 1 Year

BUY NOW BUY NOW BUY NOW

30-Day Money Back Guarantee For New Purchases e
OIS
e =B =

Canva Pro: Unlocks pro features like the Background Remover, custom fonts + ability to
save brand kit. Free 30 Day Trial.

° $12.95/month or $119.40 a year for Pro.

° | recommend getting the Free 30 Day Trial of Canva Pro for the Challenge, and
you can downgrade later if you want.
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Canva, your secret weapon
for stunning design

Design anything in minutes with thousands
of beautiful templates and images. Try
Canva Pro FREE for 30 days. Cancel anytime.

ConveriKit: Free plan includes 1000 subscribers, unlimited optin forms and landing
pages with the ability to send one automated email upon signup, and unlimited
broadcast emails (emails you send manually).

Paid plan starts at $29 for up to 1000 subscribers and includes automation (the ability
to send multiple automated emails upon signup).
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1.2 - Domain & Hosting

Go to shannonmattern.com/bluehost* and click Get Started.
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Choose the BASIC plan (it's really all you need to get started, you can upgrade later
as you grow)!

Recomimanded

Basic |us Choice Plus Prov
§2.95/mo* $5.45/mo* $5.45/mo* $13.95/mo*
Pormally $34as Morrmally S48 Horrrully §3a8e tgarrnally S350

Select Selact Safact

wWebsi 1 Wzl

stangard Performance

1incly

Expors

Derrain Privacy Distruin Privacy

Site Backup - CodeGuent Basi it Backuip - CodeGuard Basic

1 Dffice 365 Mallnax - Free 30 Days

Enter your domain name. If you already have one that you bought from someone
else, enter it on the right, otherwise, enter the one you want in the box on the left.

i# bluehost

Next we'll set up your domain.

Your domaln will be your website's address.
You can credte a new domain ar use one you aiready awn,

Create a new domain Use a domain you own

| = | )

Search avalable domains Enger your existing comain name

If you don't know what you want your website address to be yet, this will pop up and
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you can choose to add it later and you'll be assigned a temporary domain.

Choose a Free Domain Later

Can't decide on a
domain name?

Choose later! Sign up now and
receive a FREE domain credit - an
$11.99 value!

Choose Free Domain Later

If your domain name is available, you'll get this message, otherwise you'll have to
choose something different, or wait and choose it later, no biggie.

Create your account

The domain freefivedaywebsitechallenge.com is avail
able!

Use Google Single 5ign-0n to make creating your account even easier.

Enter your name and address info, then choose how long of a package you want and
your options. The longer of a term you do, the more money you'll save over time. But if
you're really on a shoestring budget you can change your term to 12 months and
uncheck all the other options, and you'll end up with a total under $60 for your

website.
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Account Information

All fields are required unless otherwise noted

First Name

Last Name

al) Business Name

Streel Address

City

State

|_

l

|
Country  ((nied States

|ﬁ

(

Please sslect o stais

ZIP Code | o

Phone Number [;123:-156-?390 JExt[ ]

*Email Address |

Package Information
Account Plan
Hosting Price 41
Primary Domain Registratio Free

Let's Encrypt S5L  Free -

Use an international number

*Your receipt will be sent to this address.

terms

If you don’t get domain privacy protection, for the first few weeks after you buy your
domain you're gonna get people calling you and emailing you about building your

website for you. If that weirds you out, it might be worth it for you to buy the protection.

| just don’t answer.
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Package Extras

Domain Privacy Protection  ©-%0.99 per month (Billed annually at $11.884r,
freefivedaywebsitechallenge.com)
Mare information

SiteLock Security - Find @ - $1.99 per month (Billed annually at $23.88/yr)
Maore information
Codeguard Basic  ©-$ 2.99 per month (Billed to end of hosting term)
Mare information
Bluehost SEC Tools Start @ -$1.99 per month (Billed annually at $23.88/yr)

More information

1 Office 365 Mailbox - 30 Day - FREE
Free Trial More information
Savings  $181.44 (63% off)

Total  $106.20

Payment Information

Fay by credit card, or see mare payment options

Credit Card Murmbar |
L = |

Sgnature/CVV2 Code
Expiration Date | 07%|/ [194

Provide code for instant verification, Exdmplu

Agree to the terms, which say this is an intro price, this card will be charged at renewal

and you have 30 days to cancel + get a full refund:

Intreductory prices apply to the first term. Money-back guarantee applies to hosting and domain privacy. All
plans and products automatically renew unless you cancel. The renewal will be for the same term length and
at the regular rates reflected in your Control Panel. The payment method you provide today, or we have on
file, will be used for renewals, unless you change it or cancel. You may cancel at any time by logging into your
account anline or by calling customer support at +1 855 G84 4546,

I have read and agree to Biuehost's Terms of Service and Cancellation Policy and acknowledge receipt of the
Privacy Policy.

Upon successful processing of your payment, you'll set your account password:
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Create a password for your new account

Something secure but memorable. You'll need it to log in to your account.

Make a note of your login info in the Password Tracker.

Then you'll log in to your Bluehost account:

Y
Nice Work!

© Hosting Login Webmail Logir
Log in to your account

scarklttmattmn.com

Forgot Password  Create Account

- I

Copyright 2020 | WP+BFF LLC | All Rights Reserved



S5+DAY WEBSITE CHALLENGE

You'll enter the name of your website (tagline optional) + click Continue.

Step ) ol 2

Let's create a website!

% What do you want to name your site?

What's your site's tagline?

Do you want a blog? ( ‘:_I“J

Do you want a online store? »

I'm not creating a website

Answer these questions however you want + click Continue.

Are you comfortable with creating
websites?

~ P " Fa
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Skip choosing a theme - we'll do this later.

That's itl Your Bluehost account is set up + you have a WordPress Site!

i bluehost 8 13Dmysten 7

&y sies Nice work, Shannon! You set up your sitel View My Site |
Mew It Ume o get your site ready 1o launch

(3 Marketplace R ATCO T a

- . Shannon's List to Launch
=1 Email & Office
Recommended

Domains

S

Customize your design

Advanced Select colars, fants, and layauts in the WordPress Customizer, \

#

Next steps:

Check your email for confirmation, follow any steps in that email to confirm your
account.
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You have a temporary domain even if you registered a new one. It will be provisioned
later, and when it is you'll get logged out of the site automatically, and then when you

log back in you'll notice your domain name is set up.

Contacting Customer Support: Go to hitps://www.bluehost.com/contact and use the

Call option. You'll get better faster service than if you do chat.

1.2.1 - Complete Domain Setup

Check your email - you'll see 3 emails:

B Menus « DIY Webmite Magic — Xy Blog - Shannon Matterm DY ¥ P Inbox () - shanon2033digma % -+
& mall.googie.com mailju/ #irbes Y Gt ®
B on = = =B B & I n B«
= M Gmail 2 ) i @
o- ' "
| comp =
WordPress com Jetpack is included with your Bluchost hosting plan, verify your email now - Jafpack iz incl 7:44 AM
I Pauseinbo Bluehait Welcome ta Rlushost! (shannoamattemdly.com) - Your Bluek 4
u Mibox 2 D T Biuehost WIS Verification for shannonmatterndly. com. Action Reguired. ﬁ i (¥ 0
%  Slarred
© 5o
1. Open the WHOIS Verification and confirm your email address.

2. Nothing to do with the Bluehost Welcome.

3. Ilgnore the Jetpack verification email - we won't be using it.

1.2.1 - Logging in to WordPress

How to get logged in:

From any web browser go to www.yourwebsiteurl.com/wp-login.php
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o i %G & A

« @ @& https://scarlettmattem.con}/wp-login.php

I apps B3 Growth University B3 PT4SH & Goodle Drive [ 6 Day Fresbie Cha.. [ wMLFB Group [ F& Notifications [ wr BFFs!

W

Username or Email Address

shanon2023

How to reset password if you ever forget it:

On your WordPress login page (www.yourwebsiteurl.com/wp-login.php) click the "“Lost
your password?2” link, then enter your WordPress Username OR email address and WP

will email you a password reset link.

Please enter your username or email address.

Username or Email Address You will receive a link to create a new password

via emall.
shanan2023
Password
Username or Email Address
ecssnsecessRsRRS =]
Ga

Remember Me
Get New Password

Lost your password?
Login
<Beckip Free 5-849) Website Challenge

« Back to Free 5 Day Website Challenge
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1.3 - WordPress Dashboard 101

Once you're logged in, the WordPress Dashboard (or back-end) looks like this. All of
the important stuff is on the left-hand side.

i Dashboard
{# Dashbosrd

Are you enjoyg Monsterhsights? o

Home

Fausgh, s wevs colected all th ol
gl cofectedall the i shananzz3@gmalicod; | RS

Mansterinsights. P Guick Draft
Dy Repon - Title
Sessions Fageviews Cantant
- I q
3 3

Bounce Rate

100%

A 100% T

iz i 2 paragrah this s

WordPrass Events and News

Top FostaPages
Arimry an s v susni rut i o8

To get to your website (or the front-end), mouse over your website name in the top-left
corner of the site and click “Visit Site”.

This is what it looks like when you're logged in on the front-end of your website - you'll
see the “Admin Bar”:

&b Free 5 Day Website Challenge  #° Customize + Mew * Edit Paga | ) Caching ¢|| Ingights Howdy, shanon2023 [§) O

To get to your dashboard from your website mouse over your website name in the
top-left corner of the site and click “Dashboard”
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S Customize B 4+ New ” Edit Page ] Caching al Insights

11 AMMASNAL b d

Before we move on in the training, we're gonna remove some plugins our host
installed that we don’t need and won't use.

You may not see all of these plugins installed on your site and that’s okay! If they're not
there, nothing’s wrong just skip it and move on.

1. On the left-hand side menu, mouse over Plugins and click Installed Plugins.

2. Deactivate and Delete the following plugins. Click deactivate if the option’s
available (if you don't see Deactivate then it's already deactivated), then click Delete
to remove the plugin.

Akismet Anti-spam

Hello Dolly

Google Analytics for WordPress by Monster Insights

Jetpack by WordPress.com

Optin Monster API

WP Forms Lite

000U

1.4 - WordPress Users

To create a new administrator user or make changes to your account go to Users > All
Users
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& Dashboard

Home
Updates

Insights

Posts
Media
Pages

Comments

Appearance

Plugins

4~ Tools
Settings

“mi Meow Apps
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Dashboard

Are you enjoying Mons!

Yes
Not Really

Welcome to Make! Get

You're aw
speed reg

Monsterinsights

Overview Report

Add New

Your Profile

Mouse over your username and click edit OR click Add New

f \
Bluehost Users addnew |

Dashboard

Posts
7 Media
Pages A

Comments

Appearance

& Plugins

Users

All Users

# Free 5 Day Website Challenge ﬂ_ + New EM caching il Insights  UpdraftPius

4 \

F
.

~ =
Are you eﬂbying Monsterinsights?

Yo
Mot Really

I (1) | Administrator (1) | 2FA Active (0) | 2FA Inactive (1)

Bulk Actions 5 Apply Change role to... ¥  Change
Username Name Email Role
E’_g‘hanpn2023 - shanan2023@gmail.com Administrator
Edit '(l-,ew 2FA
\"-H.._._ -
Username Name Email Role
Bulk Actions § = Apply Change role to... ¥  Change
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Enter a 1. username, 2; email address, 3. select Administrator for the role and 4. click
Add New User.

| # Free 5 Day Website Challenge # + New KBl Caching il Insights  UpdraftPlus

Add New User

% Dashboard

Are you enjoying Monsterlnsights?
Posts Yas

Mot Really

41 Media

Create a brand new user and add them to this site.

[
# Comments . R
-t Username (required) |

i Email {required) 2

¥ Appearance
K
L]

Plugins
- Users
First Name
All Usars
LR Last Name
# Tools Website
[§l Settings
‘W Meow Apps Password Show password
VA sec Send User Notification v| Send the new user an email about their account.
@ Ninja GDPR — SEO Editor
SEOQ Manager
i Insights Role + Subscriber
Contributor
A Use Any Font —— Authar
/IR 3 Editor

1.5 - WordPress Settings

Settings > General

1. Go to Settings > General
2. Refer to the screenshot on the next page for all the settings.
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&% Dashboard

G siteKit
Bluehost

A Posts
Media
Pages

Comments

Elementor

Templates

Appearance
K¢ Plugins
aa Users

& Tools

B Settings

General
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Coming Seon Active

General Settings

Site Title

Tagline

WordPress Address (URL)

Site Address (URL)

Administration Email Address

Membership
MNew User Default Role
Site Language By

Timezone

Caching

UpdraftPius

Shannen Mattern DIY |

Change these to your business name + tagline.

DIY Web Design + Marketing Training |

In a few words, explain what this site is about.

http://box5864 . temp.domains~shannrgd |

Leave this as is, it will change automatically
when your domain is provisioned.

http://box5864 . temp . domains~shannrg4d |

Enter the address here if you nstallation directory

it your site home page to be ¢

m your Word?

shanen2023+bluehostdemo@gmail.com | This is where all admin notifications will go.

This address is used for admin purposes. If you change this, we will send you an email at your new address to confirm it. The new address will not become
active until confirmed,

) anyene canregister This should be unchecked.
suscriber ~ | | eave as is.
English (niea states) | Choose your language.

New York ~| Choose your timezone.

Choose either a citv in the same timezone as vou or 8 UTC (Coordinated Universal Time) time offset.
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*Note - when your domain name is provisioned, you will be logged out of your website
automatically, and then when you log back in, the domain name will appear in your
address bar and in Settings > General, and you'll have a lock icon in your web browser
which indicates that your free SSL Certificate has been installed.

My DY Wensite Magic x| [ Bluaham Poreal % | @ Legin:Snannon e % | P inbox (4) - shannonic X M [Shannon Martem 017 % | fy Dashhoard « Shannoe %y Shannan Martsmn O ® -+

c B Eshannonmatierndiy.com

Aattern DTY ¥ Customize W 0 4 Mew Caching Howdy, Shannon ] Q4

Shannon Manern DIY — DIY Web D S1gn 4+ Marketing Training

Hello world!

Welcome to WordPress. This is your first post. Edit or delete it, then start

2 oM - U = y
e Recent Posts

Settings > Writing

No changes.

Settings > Reading
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Howdy, Stannce [

] + New i
Caming Scon Active

Help =

Reading Settings

Your homepage displays & Your latest posts  Leave a5 s lef now, we je Il laler afler we've made

A gtatic nage {selact balow)

Homepage:

Pasts paga:
Blog pages show at most 0 posis
Syndication feeds show the o Mema
mast recent
For each post in a feed, ® Full tewt
include

Surnmary
Yok Hheme o oW Cot

Search Engine Yisibility | Discourags search engines frem indexing this sita  CRECK 11 b 2y 2

It is up to esarch engines o fonor b
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Settings > Discussion - My recommended settings are on the following screenshot.
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Shannon Mattern DI P 0 4 New

Dashboard
Site Kit

Bluehost

Posts
Media
Pages

Comments.

Elementor

Templates

Appearance
Plugins
Users

Tools

Dashboard

Blushost

Posts
Media
Pages

Comments

Elementor

Templates

Appearance
Plugins
Users

* Tools

Bl Settings

nieral

Coming Soon Active

Default post settings

S5+DAY WEBSITE CHALLENGE

(/]

Caching UpdraftPius

Howdy, Shannon [l

Discussion Settings

s plugin is cur

Mary of the settings below

¥| Attempt ta notify any blogs linked to fram the post

(/| Allow link notifications from ather blogs (pingbacks and trackbacks] on new posts

¥ Allow people to submit comments an new posts

(These se

ings may be overridden for

al posts.)

Gther comment settings +| Comment author must fill cut name and email

Email me whenever

Before a comment appears v| Comment must be manual

Comment Moderation

Comment Blocklist

Avatars
Anavatarisan
on your site.

Avatar Display

Maximum Rating

nafault duatar

Users must be registered and logged in to comment

Autematically close comments on posts oider than | 28 days

| Show comments cockies opt-in checkbox, allowing comment author coo

| Enable threaded (nested] comments &« | levels deep

Break comments into pages with | 20 top level comments per page and the | last ~ | page displayed by default

Comments should be displayed with the | clder ~ | comments at the top of each pags

7| Anyane posts a commant

¥ A cemment is held for mederation

Comment a

ar must have a previously approved comment

Hold & comment in the queus if it contains | 1 or mare finks. (A common characteristic of commant spam is a large number of hyperiinks.)

When a comment contains any
address per line. ILwill m

of these words i
de words, so

stion

2. Ore ward or IP

in

When & camment contains any of these wards in its ca

tent, name, URL, email, or IP address, it will be put in the Trash. One word or IP sddress per line. It
will mateh inside words, so “press” will match “WardPress®,

tollcws you fram weblog to weblog appearing beside yaur name when you com

it on avatar enabled sites. Here you can enable the dispisy of avatars for people who comment

<

Show Avatars

®) G— Suitable for all audiences

) PG — Possibly offen:

usually for audiences 13 and above
R — Intended for adult audiences above 17

X — Even more mature than above

Enr ienre withaiit a cietam auatar of thair awn unii can aither dienlsu a nenarie inan Ar s aenacatan ans haesd nn thais email addrece
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Settings > Media

No changes.

Settings > Permalinks

#i Shannon Mattern DIY B8 + nNew Fd h UpdraftPius
Ceming Soor Active
shboard
T Permalink Settings
WARMING:
Chi nq your permalinks setti

gs can seriously impact your search engine visibility. it showld 2imost never be done on a live website.
ortant for SEQ.

‘WordPresa offars you the ability to ereate a custam URL structura for your permalinks and archives. Custom URL structures can improve the assthetica, usability, and forward-compatibility of wour links. A
I L

Common Settings
Comments
Elementor ! Plain nttps://shannonmotterndiy. coms/?p=123
Templates
3 Day and name nttps://shennonmatterndiy. com/2020,/86/69/sample-post/
App:
¢ Pluging ! Month and name nttps:/eshannonmotterndiy . con/20820/86/ semple-post/
! Numeric Atps:Srshannonmotterndiy . comfarchives /123
® Postname https:ffshannonmotterndiy. com/sample-posts
| Custom Structura https:/fshannonmatterndiy. com | Akpostramelk)
Awailable tags:
vedaydd || Stheurtt || Sminutesi econd¥ || %post jd% [ B pastriama J, Yeategaryh atithort J
L ) J ) J | L
Optional

I your like, you may anter custom structures for your category and tag URLS hera. For example, using topics ssyour category bass would make your category links like

Settings > Privacy

No changes.
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1.6 - Pages + Menus

How to create a new page: There @ @ Free & Day Website Challenge 1 0+

are two ways to create pages in 55 Bluchost Dashbaatd

WordPress. From the Dashboard @ Dashboard
go to Pages > Add New. Home

‘Welcome 1o Make! Gef

You're a
speed re

Monsterinsights

¥ Comments

Or click the + Sign in the Admin %Y @ Free 5 Day Website Challenge ¥ + New Caching
Bar and select Page.

[ 1 1]
iai Bluehost Dashboard
@ Dashboard

Welcome to Mak
Home

Updates
You're awesome for installing Smu

Pages are all the main pages of @@ @ Froes Day Websits Challenge B 0+
your website (Home, About, Blog, 353 Bluehost Dashboard
Work With Me, etc.) and they can | EIEEEEE
be found in Dashboard > Pages > Home

All Pages. e

| ‘Welcome to Make! Ge|

You're aj
speed ry

Monsterinsights

¥ Comments

In WordPress, first you create a page, and then you add pages to menus (if you want
the pages to display in your website navigation).
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If you don’t want the page to display in your main navigation, simply don’t add it to a
menu - then you can link to it from within another page or email or social media.

To create a new page, go to Pages > Add New.

TYIEY, = -

2. Click Publish +

x
confirm on next screen.

Status & visibility Lol

Home 1. Add your page title here. Vislbility Puhlic
Pubfish Immedistely

Start writing or type / to choose a block ® O Pending review

Featured image e

Page Attributes ~

Note: If you have the Classic Editor Plugin installed on your WordPress site, your pages
will look like this. | personally prefer the Classic editor bc you can see all the options on
one screen!

halienge @ + new ©d ® cacting ol insights  Lipdratipius

Usa Gurenberg On Ths Page

¥ Stetus: Draft Edit

Page Gullder

& Ysiility: Public £dit

i Publish immediately Edit

Duplicate this page wirth fdake Piis.

i/ BED: Mot avallable
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Repeat this step to create the following pages:

Home

About

Blog

Work with Me
Thank You

Terms + Conditions

Create a menu and add your pages to it:

Publish the existing Privacy Policy Page

After you've published your blank pages
with titles, go to Appearance > Menus.

@) @ Free5 Day Website Challenge B 0 < New

EEE Bluehost
&% Dashboard
A Posts

7 Media

B Pages

All Pages

Add New

¥ comments

v Plugins
Users

‘ Tools

Settings

Meow Apps

Add New Page

Make's builder requires the
Read through our guide abo|

| Add title

Page Builder

Premium Themes

Theme Editor
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Click “Create a New Me

nU"

+ MNew

Y & Free5 Da

@& Dashboard Menus = Manage with Live Preview

A Posts Edit Menus Manage Locations

Edit your menu h—:’!rt\

¥ Comments

Thforget to save your changes|

Purge 5G Cache

J

Give it a name. You can fitle it whatever you want, but make it meaningful to you. |
like to call it “Main Navigation”. Then click “Create Menu”.

Menus manzge with Live Preview

Edit Menus Manage Locations

Edit. your muri bukow, or cresta o s

Add menu items

v vy, Bort lorget to save rous changesl

Menu structure

Moy Mama | $Asin Navigatice)

Biwe your mera aname, then click Create Mern

Create Menu

To add pages to your menu, check the pages you want to add and click Add to

Menu.

Add menu items

Menu structure

Privacy Settings Page
GDPR - Request personal data

Privacy Palicy

e

/
Selact Al {\ Add 1o Menu

Posts
Custom Links

Categories

—

™) Delete Menu

Secondary Manu (Currerdly

Foatar Menu

Pages Menu Name  Main Mavigation m
Lot Rasantl] e kil Banseh Add menu items from the column on the 1eft.
Thank Yo
| Wark With Me =
Menu Settings
¥ Blog
7 Lbout Auto sdd pages Autamatically add new top-lavel pages to this menu
¥ Home Dispisy focation Primary Menu

set to: Secondary Mem;

Save Meny
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To reorder pages, click and drag them to put them in the order you want. To make a
submenu item, drag the item slightly to the right and it’ll stick under the above menu

item.

Menu structure

Menu Name  Main Navigation

Work With Me
Blog
About

Home

& Made with Cifex

Drag each item into the order you prefer. Click the arrow on the right of the itern to reveal additional configuration options.

Page ¥

Page

To remove a page from a menu,

delete the page, it just removes it from your menu.

Menu structure

Menu Name  Main Navigation

Home
About
Work With Me

Blog

Drag each item into the order you prefer. Click the arrow on the right of the item td

Page ¥

Page v

Page v

Page ¥
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To delete a page, go to Pages > All Pages, mouse over the page you want to delete,
and click “Trash”.

(@) @A Free 5 Day Website Challenge Divi Editio.. <> 4 B <4 New Purge SG Cache

& Dashboard Pages Add New

o Posts All (12) | Published (9) | Drafts (3)

& i

7 Media Bulk Actions % Apply Alldates &  Filter

[M Pages Title

All Pages About == =
~ "~

Edit OuickEdi(Tlah:h Yiew ' Edit With Divi
ﬁ‘._._,_/

To fully delete it (so that you can re-use the same link on another page), from Pages
click on the “Trash™ link:

-".ﬁi- # Free 5 Day Website Challenge Divi Editio... < 4 B -+ New Purge SG Cache

#% Dashboard Pages Add New

A" Posts

07 Media

IR Pages

All Pages

Add New

¥ comments

1 page moved to the Trash. Undo

—

All {11) | Published (B) | Drafts (3} | Trash (1)

Bulk Actions 3  Apply Alldatés— %4 Filter
Title
Blog — Divi

Then click on and “Delete Permanently”.
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# Free 5 Day Website Challenge DiviEditio.. <> 4 B 0 < New
@ Dashboard Pages Add New

A& Posts All {11} | Published (8) | Drafts (3} | Trash (1)

(B Pages Title

All Pages About

p— —

A Restore{__Delete Permanently Edit With Divi

Title

B Comments

A Projects Bulk Actions % Apply Empty Trash

a

07 Media Bulk Actions ¥ Apply Alldates =

Purge SG Cache

Filter Empty Trash

1.7 - Installing Plugins

How to install a plugin:

From the WP Dashboard, go
to Plugins > Add New.

Bluehost

& Dashboard

A Posts
3 Media
Pages

Comments

Users

Tools

Settings

Free 5 Day Website Challenge @

=+ Nev

Dashboard

Are you enjoying Monsterlr

Yes

Mot Really

Welcome to Make! Get up

You're awesd
speed resou

Monsterinsights
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Option #1 - Search the

Add Pluging  up=

| Ayt s i

Plugin Repository: Type the
plugin name in the “Search
Plugins...” box.

When your plugin appears, - pam

click “Install Now” Classic Ediitor Q:: NnD
Enables the previous "classic” editor and the old- Detdlls

style Edit Post screen with TinyMCE, Meta Boxes,
etc. Supports all plugins that extend thi ...

By WordPress Contributors

(668) Last Updated: 2 months ago

S+ Million Active Installations ¥ Compatible with your version of WordPress

After it's done installing,
click “Activate” You're
done!

Classic Editor

Enables the previous "classic" editor and the old- [}
style Edit Post screen with TinyMCE, Meta Boxes,
ete. Supports all plugins that extend thi ...

By WordPress Contributors

(668) Last Updated: 2 months ago

5+ Million Active Installations v Compatible with your version of WordPress

Option #2 - Download +
Upload: Download the
plugin file from the
WordPress repository, or
from the plugin’s website.
Note where you saved the
file on your computer, and
make sure the file remains

zipped (.zip)
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GO 1-0 P|UgInS > Add NeW -f\ # Free 5 Day Website Challenge B + New_ Vi Cack
H “ HSRT] S
and click “Upload Plugin B oehost Ak PlUgire] i s

#& Dashboard
Are you enjoying Murlstarlns»l{;h?s‘?

¥

A Posts Yes
Mot Really
0y Media
Pages
Featured Popular Recommended
Comments

Pluging extend and expand the functionality ¢
page.

% Appearance

K Plugins

Click “Choose File” AP (s

Navigate to where you [ m o e am
saved the file on your ;L & :-' i |
computer, click it and click | f &o o B s e ] |
open. (I'm on a Mac, this

will look different for you if

you're on a PC)

| [ peskion .
: L]
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Click “Install Now”

If you have a pluginin a .zip format, you may install it by uploading it here.

}-mnm.suLclean-himl.‘l_tmp

/ ™

Click “Activate Plugin”
Installing Plugin from uploaded file: clean-html.1.1.zip

Unpacking the package...
Installing the plugin...

Plugin.inetalled successfully.

LTHGEICRSGIGEN  Return to Plugin Installer

WordPress will redirect you
to your Installed Plugins
page on successful
installation. It looks ’
something like this: . |

Crearal Caler Fuatts

Elass Ediin

ChanR HTML

Follow the above steps, using either Option 1 (faster) or Option 2 to install the following
plugins:

e WordFence
e Updraft Plus
e Titan Antispam
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Disable Comments
Smush

Central Color Palette
Cookie Notice

Site Kit by Google
Yoast SEO
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1.8 - Business Email Address Setup

We'll set up a free branded email address so that you look super professionall

If you can swing it, | highly recommend Bluehost’s GSuite for $6/month for your business
email - way easier to use than the free account we're gonna set up in this training and
if you do that you can skip all this setup...

1. Loginto your Bluehost Account
2. Click on Advanced
3. Click on Email Accounts

@

)

i bluchost i blushost

(A] Home . .
Fino functions quickly by typing hara GEMERAL INFORMATION
shannrgd

<7 Marketplace Primary Domain

G File Manager h Images o Directory Privacy shannonmatterndly.com
= i - hared IP Address
[~ Email & Offica A o e 2 ki iy - §
= Disk Usage B Web Disk ey FTP Account
Q Q & o = 162.241.24.104
5\ Domains B e FTP Connections 6“49 Anonymous FTP ‘B Git™ Yersion Control Home Directory
J Momel/shannrgd

bluahost
EfE Advanced
Server Iﬂfurn'atlon
DATABASES —
- STATISTICS
phpMyAdmin o MySCLE Databases MySOLE Database
Wizard

1 (20%;)
@ Remote MySOLE o Postgra$Ql Databases I-'c!s!:greSUL Database -
Wizard
E phpPgAdmin MySQLE Databases
1420 {5%)
= Server '

EMAL

0Jso
Disk Lizapa
L mp Ferwarders 1 + Emall Routing 222,95 MB /50 GB - (0.44%)
|
Mailing Lists e Global Email Filters
= MySQL® Disk Usage
o Ernail Filtars " f > Email Daliverability '51:?'"' Address iImperter 13471 MB /498 GB (D.O3W)

- #3 Epiam Eilrsre ﬁ Frirruntinn ‘ Ry Trannar
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Click on Create

@ Menus ¢ DIY Wetsite Magie— X (0 Dastboard < Shannon Matter, X @@ cPanel - Email Accourts x  +
L C @& cpanel-box5864 biuehost.com/cpsess07 21050808 frontend/biuahost/email_accounts/index. htmi b4 E\ﬂ ;'. fr® & G
I oapps BED ONADues B3 Courmes Shortcuts B Accelermior B3 Growth U, B3 PT4SH & GoogleDdve @ BOWCOLF [ Calender ] FU Group Links B3 WDA Pages = 3 Other Spokmarks

blueh

r Home

3 Emall Accounts
W My Sites 51 Ermail Accon

Marketplace
This feature lets you create and manage email accounts. Want to learn more? Read our d

1 Email & Office

(@) pomains F
st Filter: @ #en
.

W CEIETE
9 Acvanced

ACCount & @ [

Restrictions Storage; Used [ A

= Server

Loading your email accounts ..,
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Follow the steps on the next screenshot to set up your email account. Note your
password in the Password Tracker.

[T mam oY
i bluehost 5 bluehost ®
/F] Home
Ernall Accounts
B My Sites List Emall Accounts - Create 3 £mal Azcount
3 Marketplaca
Use this page to create new emall addresses for any of the domains on your cPanel account, Want to fearn more? Read our decumentatlon 37,

] Email & Offica

Tl Shiow i telp (2

CREATE AN EMAIL ACCOUNT Show/Hide Help @ A available 1 Used
o : 1. Enter what you want the first part of your email sddress to be hers,
‘&) Domains Username (@
i Bshannonmatterndiy.com MISSING A DOMAINT

%i Advanced s, and
A Subdomains let you create
subsactions of your domains
= Server < Aan Gk 5
2 Cre password here. /& Manage Subdomain
Password

Aliasas et you point a domain
tewards ancther of your domains'

49  GENERATE -

content,
storage Space (& F Manage Aliases
® 1. Leave this as is.
100 XER
O 106 MA WEED HELP?

& About This interface

send a welcome email with Instructions to set up a mall
client, 4, Make sura this box is checked.

U Stay on this page after | click Create,

L AN 5, Click croate 4 GO BALK
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Click on Check Email:

‘A1 Hame
) Email Accounts
Wi My Sites List Emall Accounts

{3 Marketplace

## bluehost oR=K

This featura ets you create and manage email accounts. Want ta learn more? Read our documentation & 3 available 2 Used

1 Email & Office
Search Q %< < | Pagelofi=

(@) Domains e S T T S o578

Filter: B} Fesricted  DofaulAccount  Exceeded Storape s
#R Advanced U W DELETE 0.

Account A& Domain Restrictions Storage; Used / Allocated / % —
= Server =
I % hello@shannonmatternd... & Unrestricted 0 bytes / 100 MB / 0% @'”‘“EWQ & MANAGE [} COMNEET DEVICES
i \-‘--_.--"

Set a default email service for when you check it online through Bluehost, and
configure it on your own devices using the steps in the next screenshot:
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53.51 KB /100 MB om - (LOGOUT

Choose a Default Webmail Application

Schorde  roundeuce

1. Click "Set as Default" to set
Roundcube as the default
Set as Default Set as Default Set as Default

SquirrelMail

webrmail
for

Q) nues

For more emall configuration options, click the User Preferences menu in the tep navigation bar.

When you access an email account through a desktop email application such as "MacOS® Mail.app® for “Lion” (10.7+)", the email application will require specific informaticn about your email account, You can use the
auto-configure options below to attempt to automatically configure your email application. If the available options are not compatible with your application, you will need to use the Manual Settings information

Mail Client Automatic Configuration Scripts

Listed below are the available mail client automatic configuration scripts. Select the script for your mail client and cperating system.

Application Protocols
i05 for iPhone/fiPadf/iPod and MacOS® Mail.app® for Mountain Lion (10.8+) IMAP over SSL/TLS  IMAP
MacOS®E Mail.app® for “Lion” {10.7+) @ IMAP over SSL/TLS  IMAP
MacOS& Mail.app® for “Pre Lion" (10.4+) @ IMAP over SSL/TLS  IMAP
Posthox® Auto Config
Mogzilla Thunderbird® - 2 Auto Config

2. If you want 1o set this email up
KDE Kmail on a mail app you have on your Auto Config

computer, choose the one you

Mail for Windows® 10 have and follow the setup Auto Discovery
Microseft Qutlock 2010® for Windows® instructions. Auto Discovery
Windre |ive M aili & IMAD ruar SSI/TIS  PAPT nuer SSHITIS  IMAP BAPR (Pnst Offica Brafnenl w3l
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To check your email via Bluehost:

1.
2.
3.
4.

Click on Email + Office
Click Manage
Click Check Email

Log into your Bluehost Account

bluehost

~
Home

Email & Office

My Sites

Marketpls i
larketplace shannonmatterndiy.com

Email & Office

) Domains

Advanced

-

Upgrade email | Manage |)

L

&
&

et

z bluehost

Hame

3 Email Accounts
My Sites List Emall Accounts

Marketplace

This feature lets you create and manage email accounts, Want to learn more? Read our documentation ' 3 Available 2 Used
Email & Office
Bearch Q f = =
Domains Filter: Festricted  Default Account Ewce -
3013
Advanced 0 W OELETE G-
Account A @ Domain Restrictions Storage: Used / Allocated / W
Server ) i ,_\\
> hello@shannonmatternd... + Unrestricted  53.51 KB/ 100 MB /0.05% —/ F MANAGE [ CONNECT DEVICES
|
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Webmail WA5351KB/100MEB R helfo@shannonmattemdiycom ~  GrLOGOUT
roundcube e = ontaces g Sewtings
- +
- B ,_, - sew Al s Q=
Refredh Compose " Mark Mare
0 inbox & o- s * Fem | Daw 520 ~ &
& Drafts I [shannonmatterndiy.com | Email configuration sectings for “helio@shannonmanterndiy com™ cPanel on shanponmatierndiv, . Today 08,02 54 KE 3
& sent
B3 junk

That's it! So you can choose to check your email from inside Bluehost, or from your
phone or computer once you've followed the setup instructions Bluehost gave you for
your device or email app.
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Day 2 - Setup

2.0 - The Big Picture

In Day 2, we're going to go through all the WordPress + plugin settings we need to
configure - just one fime and then we never have to look at them again!

2.1 - Security - WordFence

When you installed WordFence in Day 1, the following notices appeared at the top of
your WordPress Dashboard:

0 Shannon Mattern DIY @ < Mew KMl Caching  UpdraftPlus Howdy, Shannon [l
Home ” - - o ; - i y
To make your site as secure as possible, take a moment to optimize the Wordfence Web Application Firewall: | CUGCK HERE TO CONFIGURE
Upe
E It your cannot complete the setup process, click hers for helo.
G Site Kit
Dashboard
* Posls
9y Media | Do you want Wardf to stay up-to-dat leally? Yos, enabie aulo-update. | Me thanks

1. Click Yes, Enable Autoupdate
2. Click Click Here to Configure

0 Shannon Mattern DIY @ < Mew KMl Caching  UpdraftPlus Howdy, Shannon [l
@& Dashbeard
2. Click on Click Heve to Configure
Home » 4 - o . " .
To make your site as secure as possible, take a moment to optimize the Wordfence Web Application Firewall: | CUGCK HERE TO CONFIGURE

Upe

E It your cannot complete the setup process, click hers for helo.
G Site Kit

: Dashboard
A Fosts

- Do you want Wardf to sta dat

B Media | xe [

3. Follow the steps on the next screenshot:
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5 Shannon Mattemn DIY @8
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Caching  UpdrafiPlus

Optimize Werdfence Firewall I you cannot complets the selup process, ok here for heip @

To rrskeer your sile a5 Secure as possible, the Wordfenee Web Application Firewall is designed to run via a PHP setting called
auto_prepend_file , which ensures it runs before any potentially velnerable code runs.

MOTE: If you have separate WordPress inatallations with Waordfence natallzd within a subdirectory of this aite, it is
recommeanded that you perform the Firewall installation procedare on those sites before this one.

Wever NOLT BEVET T besed on our tests. but If vou know vour web server's configuraiion. nlease select

You'll either get a message that the firewall setup was successful, or one that it’s sfill
configuring. Either way, you're done and you can move on to the next step, which is
configuring WordFence's options.

Screenshots of all my recommended settings are on the following pages:
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L]

# Shannon M.

hbeard

Element

App tla!

Plugins 4

SEO

E® Titan Anti-spam

Wordience
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4+ New Wl Caching UpdrafiPlus

RESTORE DEFAULTS CAMCEL CHANGES SAVE CHANGES

M All Options EXPAND ALL ‘
These options are also avallable throughout the plugin pages, In the relevant sections. This page |s provided for easier setup for experienced Wordfence users

Wordfence Global Options
Wordfence License -

Your Wordfence License

License Key @ 3acidaetd7adBbl calebbechbadidbb?Ta11b7ead 56057 07bd4dbaliddbdasdedblc e192ffa234be 2 56b5d 24 bealdeT 5FA5 302 004606 23 0e0bdbcat 34602 6 d
Wiew Customization -

n Display "all Options” menu em
Display "Blocking” menu item

Display "Live Traffic® menu iterm

General Wordfence Options -

ﬂ Update Waordfence automatically when & new version is released?

Automatically updates Wordfence 1o the newest version within 24 hours of a new

RARE.
Where to ermail alerts hello@shannonmatterndiy com

How does Wordfence get IPs

@ Let Wordfence use the most secura method to get visitor IP addresses. Prevents spoofing and works with most sites. (Recommended)
Use PHP 2 built in REMOTE_ADDR and don't use anything else. Very secure if this iz compatible with your gite.
Lse the X-Forwarded-For HTTP header. Only use if you have a front-end proxky or spoofing may result.

Lige the X-Real-IP HTTP header, Only use if you have a front-end proxy or spoofing may result,
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Dashboard Notification Options -
Updates Needed [Plugin, Theme, or Core)

B scenstaws

Dashboard nofifications will also be displayed for Security Alerts, Promotions, Blog Highlights, and Product Updates. These notifications can be disabled by upgrading to a
premium license.

UPGRADE TO PREMIUM

Email Alert Preferences -

ARN MORE

T Email me when Wordfence is automatically updated
omatic updates enabled (see above), youl'll get an emadl when an update occurs,

If you have i
Email me if Wordfence is deactivated

Email me if the Wordfence Web Application Firewall is turned off
ﬂ Alert me with scan results of this severity level or greater: Critical -

Alert when an IP address is blocked
Alert when someone is locked out from login
| Alert when someone is blocked from logging in for using a password found in a breach
Alert when the “lost password” form is used for a valid user
Alert me when someone with administrater access signs in
Only alert me when that administrator signs in fram a new device or location
| Alert me when a non-admin user signs in
Cinly alert me when that user signs in from a new device or location
Alert me when there's a large increase in attacks detected on my site

Maximum email alerts to send per hour

L]
@ means unlimited alerts will be zent
Activity Report -
Enable email surmmary . -

wircontent/cache

List of directories to exclude from recently madified file list Wprcontent il

Enahle activity report widget on the WardPress dashboard
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Firewall Options

Basic Firewall Options

Web Application Firewall Status

Enabled and Protecting: In this mode, the Wordfance
Web Application Firewall is actively blocking requests
matching known attack patterns and is actively

Protection Level

Extended Protection: All PHP requests will be
processed by the firewall prior to running.

Real-Time IP Blacklist

Premium Feature: This feature blocks all traffic from
IP's with a high volume of recent malicious activity
using Wordfence's real-time blacklist

protecting your site from attackers. oon
If you're moving te a new host or a new instaliation

lacation, you may need to temporarily disable extended

UPGRADE TO FREMI | LEARN MORE

Enablad and Protecting v protection to avoid any file not found errors. Use this
action to remave the configuration changes that
enable extended protection mode or you can remove
thern manually.
REMOVE EXTENDED PROTECTION
Advanced Firewall Options -

Delay IP and Country bBlocking until after WordPress and plugins have loaded (only process firewall rules early) .=

Whitelisted IP addresses that bypass all rules

Whitelisted IPs must be separated by commas or placed on separate lines. You can specify

anges using the following formats: 127.0.0.1/24, 127.0.0.1-100], or 127.0.0.1-127.0.1.100
Wardfence automatically whitelists private networks because these are not routable on the
publie Internet

Whitelisted services
Sucuri

Immediately black IPs that access these URLs 2

Facebook Managewp Seznam Search Engine

uptime Robot [ StatusCake

Separate multiple URLs with commas or place them on separate lines. Asterisks are
wildcards, but use with care. If you see an attacker repeatedly probing your site for a known
vulnerability you can use this to immediately black them. All URLs must start v *without
quotes and must be relative. e.g. /badURLone/, /banrnedPage.ltml, /dent- s/URL/,
fstarigiwith-=

Ignared P addresses for Wordfence Web Application Firewall alerting 2

s must be separated by commas or placed on separate lines. These addresses will
ed from any alerts about increasad attacks and can be used to ignore things like
standalone website security scanners

Rules %

Category Description
@ whitelist Whitelisted URL
Slider Revolution: Local File Inclusion
S0L Injection
X85 Cross Site Scripting
(:, file_upload Malicious File Upload

& Directory Traversal

LFI: Local File Inclusion

[ O XXE: External Entity Expansion
[ g vee Azewidonnallans R &0 YE2 HTAMI iniectinn in inlina. lawaSerint
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Brute Force Protection

Enable brute force protection
This option enables all "Brute Force Protection’ options. including strong password enfercement and invalid login throt:

Lock out after how many login failures &

Lock out after how many forgot password attempts

Count fallures over what time period

Amaount of time a user is locked out 7

Immediately lock out invalid usernames .

Immediately block the IP of users who try to sign in as these usernames
T enter to add a username

=admin = administraior

Prevent the use of passwords leaked in data breaches

Additional Options

Enforce strong passwords

ﬁ Don't let WordPress reveal valid users in login errors

Prevent users registering 'sdmin’ username if it doesn't exist

Block IPs whe send POST reguests with blank User-Agent and Referer

Custom text shown on block pages @

OFF
0. You can modify individual eptions below. m

v
0 v
1 hour A

v
For admins oaly v

Force admins and publishers to use strang passwords (recomm. v

Prevent discovery of usemames threugh FZauthor=N' scans, the oEmbed AP, and the WordPress REST AP 2

k password strangth on profile update ©

e Real-Time Wordfence Security Network

. Participate i

Rate Limiting

Enable Rate Limiting and Advanced Blocking
WOTE; This checkbox enables ALL blacking/shrottling functions including I

Haw should we freat Googles crawlers

If anyane’s requests exceed

If & crawler's page views exceed 7

IF & crawler's pages not found {£04s) exceed

IF & human's page views excesd 0

If 2 humar's pages not found (404s) exceed 2

How long is an IP address blocked when it breaks a rule

Whitelisted 404 URLs
These URL patterns w

ded from the throttling rules used to limi lers.

iy and advanced blocking, and the “Rate Limiting Rules”

o= [

Verified Google crawders will net be rat

» then throttie it -
Undimited = then throttieit -
= then throtileit -
Unlimited » then throttieit -
= then throtiieit -

favicon.ico
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Whitelisted URLs -
Add Whitelisted URL/Param = The URL/parameters in this table will not be tesied by the firewall They are typically added while the firewall |5 in Leamning Maode or by an admin wha
identifies a particular action/request is a falze positive

Param Type: POST Body -

DELETE | ENABLE DISABLE Filter By: LIRL - FILTER

Enabled URL Param Created Source User P

No whitelisted URLs currently set.

Manitor background requests from an administrator's web browser for false positives

Front-end Website Admin Panel
Blocking Options

Advanced Country Blocking Options -

Put Geographic Protection In Place With Country Blocking

Wiordfence country blocking is designed to stop an attack, prevent content theft, or and malicious activity that originates from a geegraphic region in less than 1/300,000th of a
second. Blocking countries who are regulary creating failed logins, a large number of page not found errors, and are clearty engaged in maficious activity is an effective way 10
protect your site during an attack.

UPGRADE TO PREMIUM

Scan Options

Scan Schedufing -

Schedule Waordfence Scans DISABLED @

@ Let Wordlence chonse when to scan my site (recommended)

5 Premium Feature

Basic Scan Type Options -
Limited Scan Standard Scan High Sensitivity Custom Scan
For entry-level hesting plans. Our recommeandation far all websites For site ownars wh think they may Selected automatically when General
Provides limited detection capability Provides the best detection capability have 1 hacked. More thorough but Options have been customzed for
with very low resource utilization. in the industry. may preduce false positives. this website.
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General Options

O 0B D DD DDBEBGE

Premium Feature =

Pramium Feaature

Pramium Fealure

Scan for misconfigured How does Waordfence get 1Ps %

Scan for publicly accessible configuration, backup, or log files =

Sean for publicly accessible quarantined files

Scan cora fles againgl rapository versions for changes

Ecan thame files against repository versions for changes (2

Scan plugin files against repository versions for changes

Scan we-admin and wp-includes for files not bundled with WordPress 5

Scan for signatures of known malicious files

Scan file contents for backdoors, trojans and suspicious code

Scan file contents for malicious URLs =

Sean posts for known dangerows URLs and suspicious content 2

Scan comments for known dangerous URLs and suspicious content

Scan WordPress core, plugin, and theme options for known dangerous URLs and suspicious contert

Scan for out of date, abandoned, and vulnerable pluging, themes, and WordPress versions

Scan for admin users created outside of WordPress

Check the strength of passwords

Manitor disk space 7

Manitor Web Application Firewall status

Scan fMles outside your WordPress installation

Scan images, binary, and other files as if they were executable
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Performance Options -
B Use low rescurce scanning (reduces server boad by lengthening the scan duration) 7

Limit the number of issues send in the scan results emall

d sues wil be sent

1000

Dor emply means uli

Time limit that a scan can run in seconds

How much memary should Wordfence request whan scanning
ey sire in megabytes

Maximunm execution time for each scan stage

O for defsult. Must be 8 or greeter and 10-20 or higher & recommen ded for moel servers

Advanced Scan Options W

Exclude files from scan that match these wildsard patterns {one per ling)

Additional scan signatures {one per ling) =

Tool Options

Live Traffic Options -

Traffic lngging mode SECURITY ALL TRAFFIC

u Oon't log signad-in users with publishing access

List of comma separated usernames 1o ignare

List of comma separated IP addresses 1o ignane

Browser User-agent 1o ignore

Amaoum of Live Traffic data to store (number of rows) 2000

Maximum days to keep Live Traffic data (minimum; 1) 30

Import/Export Oplions

Login Security Options

Login Secutity options are available on the Login Secufily options page LOGIN SECURITY OFTIONS

Importing end exporting of options is ayvailable on the Toolz page IMPORT/EXPORT OFTHINS

Tharik yau for e 1 with WordPyess

Varsion 5.4.1

That's it - you're donel
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2.2 - Backups - Updraft Plus

You installed a plugin yesterday called Updraft Plus for backups. Here's how to
configure it:

Go to Settings > UpdraftPlus Backups

Click on the Settings tab.

Set “Files backup schedule” to Daily and retain for 14 days.

Set “Database backup schedule” to Daily and retain for 14 days.

Choose where you'll save your backups.

Choose what will be backed up (see screenshot below)

Follow the steps to connect Updraft Plus (I recommend Google Drive or Dropbox
- screensho’r shows Google Drive)

Nooah~owbd -

yMattern DIY 1 4 Mew Wl Caching UpdraftPlus Hewy, Shannan [l
@ Dashkoard UpdraftPlus Backup/Restore
G Site Kit = =
UpdraftPlus Premium: enhanced remote storage options Dismiss
& Po i Erhanced storage options for Dropbox, Google Drive and 3. Plus many more options.  Get Premium
qv @
3 LindraftPlua Com | Premivm | Mews | Twitter | Suppor | Newsletter sion-up | Lead developer's homepage | EAGS | More pluning - Version: 1.16.26
] - e

Backup /Restore  Migrate {Cloné  Settings  )Advanced Tools  Premium / Extensions
¥ comments <4 e

I8 Elementor Files backup schedule: Dally ~ |and retaln this many scheduled backups: | 14
4. Change both options te Daily + 14 to have

& Templates
P AU two weeks of full backups.

Database backup schedule: Daily w | and retain this many scheduled backups: | 14
&N
i Pl - 5 %
L To fix the time al which a backup should take place, (e.g. if your server is busy at day ard you want to run
F overnight), to take incremental backups, or to configure more complex schedules, use UpdraftPlus Premium
2
Z B Choose your remaote storage
B Ssettings ! {tap on an icon to select or | " UpdraftPius Vault 7 W@ Fe |7 83-Compatible (Generic)
unsefact):
2% Drophox B Microsoft Azure B openstack (it
ing
Amazon 53 I sFiPfscp DreamObiects
M
5. Choose where you'll m Rackspaca Cloud Files f } Google Cloud Email
store your backups - |
recommend Google a i &
s / Goagl Ve
Drive or Dropbox (or = i \! St
you can pay for the
Updraft Plus Vault). Zdia, Microsat OneDrive D wenDav
pdraftPlus Backups I 2 You can send a4 backup to more than one destination with an add-on
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Google Drive

Please read this privacy policy for use of our Google Drive authorization app (none of your backup datais
sent to us).

Google Drive Folder: UpdraftPius

To be able to set a custom folder name. use UndraftPivs Premium,
Authenticate with Google: belaw] then come back he
ve. g, C this link and follo e steps to
ft Plus to your Google Dri

onoe

Include ir files backup: ~ Plugins o )
7| Themesz 1. Make sure

¥ Uploads

Exclude these from Uploads:

backup™ -G nese asis
*hackups L
backwpup* @ x
wp-clone & %
snapshats & =

+ Add an ex

sign rule

¥| Any other diractories found inside wp-contant

Exclude these from Others: NESE 85 15

uparade & X
cache & x
updraft & %
backup® £ x
*backups -
mysql.sgl £ x
debisg.log & ox

+ Add an exclusion rule

The above directories are everything, except for WordPress core itself which you can download
afresh from WordPress.org. See also the "More Files" add-on from our shop,

an ancrunt vnur database hackun. i can akso

TR TSR PR R Don't want tobe soied on® U ndraftPlus Pramiom o
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2.3 - Comments + Image Optimization

Disable Comments

Use this to disable comments on your web pages (and allow them only on blog posts)

qQ. Plugins > Installed Plugins > Disable Comments > Settings & check the following
options, then click Save Changes.

Disable Comments

Everywhere: Disable all comment-related controls and settings in WordPress.
Warning: This option is global and will affect your entire site. Use it only if you wal
® . On certain post types:

Pasts
+'| Pages
v'| Media

Disabling comments will also disable trackbacks and pingbacks. All comment-rela
overridden for individual posts.

Save Changes

Smush

This plugin compresses your website images so they load faster (good for your
impatient website visitors and SEQO).

1. Go to Smush > Settings and follow the setup wizard, saying yes to every
option (sharing plugin data optional)
2. Bulk smush any images you might already have on your site.
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Elementor

Templates

Appearance

g Users

Tools

Wordfence
=

\7} Smush

Dashboard

Elementor

Templates Automatic Compression

Appearance
¢ Plugins
o Users

Tor
@ Automatically optimize new uploads

Wi

\%J) Smush

Dashboard
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uehost

Dashboard

Comments

Elementor

s Users

Wordfence
-
\7} Smush

Dashboard

Comments

Elementor

Templates

Appearance

tings
Wordfence
) Smush

Dashboard

S5+DAY WEBSITE CHALLENGE

10110

EXIF Metadata

@ ' stnip my image metadata

@ Enable Lazy Loading
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Blus

Dashboard

Pages l I I e

Comments

Nentor

Templates Usage Data

Appearance

Allow usage data tracking

 FIMISH SETUP WIZARD

0 Smush
Dashboard

1 Pro

0 ¢«

# Templates Test B9

Blughy Thanks for updating Smush! Did you know she has secret super powers? Yes, she can super-smush images for double the saving: i - 2
original | 5, hulk smiush thousands of Images in cne d serve 'em up In 3 next-gen format{WebP) with one-click wia her blazing-fast Try Smush Pro Fras
i Dashboard CDN. Ge

i e DASHBOARD T

Pages

Comments

0.0..

»
I8 Elementor

Ilnage Resize Saulngs Ropaze I
=

Directory Smaush Savings

Appaarance o
B 10 1
-
Is

E settings Bulk Smush " Bulk Smush 2l imanes via your Madia Library

Wardf Directory Smush
) Smush Integrations Bulk smush detects images that can be cptimized and allows you 1o compress U
Dashboard Lazy Load e

30 Pro CDN shanon2023, you have 17 attachments that need smushing!
(4 ] CLTT Tools

Settings
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2.4 - Site Kit by Goodle - Analytics + Search Data

In this module you'll set up a Google Account (if you don't already have one - if you
use Gmail or Google Drive or GSuite for your email, you already have one but you can
create a separate one for your business if you want.

Site Kit will walk us through set, a Google Search Console Account and connect them
both to your website via the Site Kit by Google Plugin.

Google Analytics tracks your website traffic - like how many visitors you get, where
they came from, what they looked at and what page they left on. Students inside my
Website Marketing Lab learn how to leverage this information to get more traffic,
subscribers and customers. For now, we just want to make sure you've got the tracking
set up so when you're ready to analyze it, you have the data.

Google Search Console tracks what search results you appeared in and what search
terms people used and clicked on to find your site. It's also how you tell Google your
site exists and to index it and serve it up in search results.

Following along with the next set of screenshots in order to set up Site Kit!
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# TemplatesTest ® 4 New Caching

& Dashboar -~ . 2
{= SiteKit
G site Kit
Dashboard
Bluehost
. . . . .
# bo Sign in with Google to set up Site Kit
@ Medis
The Kit service will guide you through 3 simple setup steps
Pages
B Ccomments
Your site may not be ready for Site Kit
1= 3
Looks like you may be aching plugin w ase deactivate any caching plugins befare
ES Templstes i . > i
setting up Site Kit. You may reactivate them onc
& Ap
£ Pluging
2l wing Tracking of ananymaodis uaage mats. All data are traated In acesrdance with Google Privacy Policy
- P N
- W starTsETUR B
o \. )/
B Settings —
Wordfence
7 Smush
(4] u
Thank pou for creating with WargPress Version 5.4,
G Site Kit Meed help?
’ . - | 1
2 Welcome to Site Kit! Let's get you set up.
To verify that you own templates shannonmattermn.com and help set up your Search Console property,
sitekit.withe 0M wants to access templates shannonmattern.com and your Google Account data
You'll need 1o sign in with your Google Account 1o start the process.
1 Verify site ownership
2 Allow templates shannonmattern.com to access Google
Account data
3 Setup Search Console ' ‘
GOOg|e Privacy Terms About Google Google Products
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Lz Sign in with Google

Choose an account

1o continue to Site Kit

Shannon Maltern
ahannoniwp-bif com

Shannon Mattern
shanon2023iigmaile

or create a new one for your business, Doesn't matter
which one you choose. We're gonna create a new
account in this tutorial.

e Shannon Mattern

ahannonmatterndly@gmad.com

i —
- q_h___\_\\
Q @ Use another account /
e -
S —

To continug, Google will share your name, email address,
language preference, and profile picture with Sie Kit.
Before using this app, you can review Site Kit's

privacy policy and terms of service.

English {United Ststes) ~ Hedp Privacy Terms

You can use an existing Google account if you have one,

G sign Inwith Google

Signin

o continue to Site Kit

Emall or phone

Fargot email?

. . T
/’ .
{ Create account ) m
.
M ___—__,/
English (United States) - Hetp Pilvacy Terms
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Google
Create your Google Account

Lset neme
Mattern

Usemrarme
shannonmatterntemplates @gmail.com

Wou ean use batters, rumbers & periods

Use my current email address instead

Eordim

U=e 8 or more characters with a mix of letters, numbaers £
symitsals

Sign in instead

English (Linited States) -

® |=

One account, All of Google
working for you,

Halp Privaey Terms

Google

Shannon, welcome to Google

@

shanmanmatterntemplates@amail com

Phere numibes [opticnal)
= - [

We'll use your number for account security. Itwan' be sisible to
others,

Recovery email addrecs {optional]

Viaill usa it 10 kaeq your account secure

Morth - Dray Year

Your birthday

Gender -

Why we ask for this information

I

Back m

Your parsonal info is private £ safa
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Google
Privacy and Terms

Ta create a Google Account, you'll need to agree to the
Terms of Service below.

In addition, when yous create an account, we process your
informetion as described in our Privacy Policy, incleding
theze key points:

Data we process when you use Google

When you set up a Google Account, we store
Infarmation you give us like your name, email address,
and telephone nurmber.

When yvou use Google services to do things like wiite a
message in Gmall or comment on a YouTube video, we
store the information you create. collect & how s used
When you search for a restaurant on Google Maps ar

watch a video on YouTube, for example, we process

information about that activity - including information

like the video you watched, device IDs, IP addresses,

cookie data, and location

« We algo process the kinds of infarmation described

above when you use apps or sfies that use Google

services like ads, Analytics, and the YouTube video

player

You'ra in control of the data we

Why we process it
‘We process this data for the purposes described In our
palicy, including 1o

« Help our services deliver more useful, customized
content such as mene relevant search results;

= Improve the quality of our services and develop new
ones,

+ Delver personalized ads, depending on your accourit
setling s, both on Google services and on sites and apps
that partner with Google;

= Irmprove security by protecting against fraud and abuse,
and

« Cenduct analytics and measurement 1o understand how
our sefvices are used. We also have partners that
measuse now our services are used, Learn maore about
these specific advertising and measuremant pariners.

Cambining dala
We also combine this data amaena our services and across
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Grant Site Kit permission

Wiew and manage Search
@ Console data for your
varified sites

P
P
Dany [ Allow )

-

Grant Site Kit permission

Manage the list of sites and
domains you control

—

.
Deny ( Allow |
\"‘--.__,_./'
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Grant Site Kit permission
View and manage Search

# Conscle data for your
verified sites

————
Deny ( n_llow)

Grant Site Kit permission

Manage the list of sites and
domains you control

o
Deny ( Allow ]
R
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Confirm your choices

o shannenmattemtamplates@gmallcom

You are allowing Site Kit to:

" View and manage Search Console data for your
verified sites

Manage the list of sites and domains you control

Make sure you trust Site Kit

You may be sharing sensitive info with this site or app.
Learn about how Site Kit will handle your data by reviewing
itz terms of service and privacy policies. You can always
see af refmave access in your Gaogle Account

Leamn about the rigks

(=

5 Site Kit Need help?
& Welcom Site Kit! Let'
2 Welcome to Site Kit! Let's get you set up.
1 Verify site ownership
Let's verify your ownership of templates.shannonmattern.com. We'll need to add a verification token to your
site HTML code.
L~ —-E_ﬂ\
b |
| Fancel
2 Allow templates.shannonmattern.com 1o access Google Account data
3 Setup Search Console
GOOQ'E Privacy ~ Terms  Aboul Google  Google Praducts
i I shannenmatiern.canywe: inji i kit prony. pagoeoglesiteil_cede=sieki eBLyxd tehil_site code=4%2F0gFITIWnRdRgD-PICGYDSIWUMIdOcE M etBlve ALOWPWUIBGPL.
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(& Site Kit Need help?

5 Welcome to Site Kit! Let's get you set up.

0 You're a verified owner of templates.shannonmattern.com

2 Allow templates.shannonmattern.com to access Google
Account data

Now that you're a verified owner of templates shannonmattermn.com, your site wants to sccess your Google

Mccount data to display metrics on the Site Kit dashboard,

You can view of remove access for templates.shannonmattem.com in your Site Kit dashboard atany time,
.
- .

' \

f \

III' m e
A Fd

. -

3 Setup Search Console

{5 Site Kit Need help?

5 Welcome to Site Kit! Let's get you set up.

0 You're a verified owner of templates.shannonmattern.com
& templates shannonmattern.com can access your Google Account data

3 Set up Search Console

Well add templates shannonmatlern.com to Search Console so you can see how people find your site on
Search.

| Addsite j' Cancel

- e—

GOOgIe Privacy — Terms  Aboul Google  Google Products
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& Site Kit Need help?

5 Welcome to Site Kit! Let's get you set up.

@ You're a verified awner of templates.shannonmattern.com
Q templates shannonmattern.com can access your Google Account data

o templates.shannonmattern.com is set up in Search Console

Congratulations!

You successfully set up Site Kit. You can now see how your site appears in
Search, how many visiters you got from Search, your popular pages, and
how peaple found them from Search,

_— =N

@ o to my Dashboard "? N\
: i \

Dashboard & . % )
~7 Slte Klt © shannonmatterntemplates@gmail. com v

G Site Kit

Dashboard

Congrats on completing the setup for Site Kit!

Mow you'll be able to see how your site |s doing In search. To get even more detalled stals, activate more

Blushost medules, Here are our recammendations for what 1o include in your Site Kit; B B
/_,—"_'_ _"-\...\_\‘
Po //' "\\ TR
2 1 Search Console Y AdSense (’ \l e Ez?;rsnp:ed
Pages @ connvcred Connect Service €@ \ ,r"l Canmest Sorvice @
. Fd
. mments ‘““u.._ﬁ__ .o P
— OK, Got it!
i Elementor
B Templates
e Site Overview B e
< Flugins Search Funnel
- How your gle ap| d In Search reswsts and how many visitone you gat from Search.
> ols
B Settine Search Console Gathering Data Learn more about what visitors do on your site.
W o Search Console data is not yet available, please check back later. Connecting with Google Analytics to see unigue vistors, goal
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G Sign In with Google

Choose an account

1o continue ta Site Kit

Shannon Mattern
shannonmarerramplates@gronil com
e

e ———
(%) Useanother account

To continue, Geogle will share your name, emall address,
language preference, and profile picture with Sie Kit.
Before using this app, you can review Site Kit's

privacy pelicy and terms of service

English (Unlted States) - Help Pilvacy Terms.

Grant Site Kit permission

View your Google Analytics

data
- @
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G Sign in with Google

Confirm your choices
e shanr om

You are allowing Site Kit to:

View your Google Analytics data

You already gave Site Kit access to!
. Associate you with your personal info on Gaogle:

See your persenal info, including any personal info
you've made publicly available

. View your email address

Wiew and manage Search Conscle data for your
verfied sites

. hManange the list of sites and domaine you cantral

Make sure you trust Site Kit

info with this site or app

£ by reviewing
terms of service and privacy policies. You can always
s8e of remove access in your Google Account

Learn about the risks

Cancel

i Ter

Dashboard . .
oo G Slte K!t © shannonmattermemplates@gmail.com v
G Site Kit
Analytics COMNECT SERVICE
Sattings .1 Analytics
Bluehy
Create your Analytics account
We've pre-filled the required information for your new account. Confirm or adit any
B Madia

Pa Aneoi Pr ¥ Wi

OmMMments templates shannonmat

B

[ ]
E Elementor
=

¢ Templates

New York Time b

2 Appearance

A Phiging You will need to give Site Kit permission to create an Analytics account on your behalf and also accept the Google Analytics terms of service.
o Users i
4 To @l CREATE ACCOUNT
- BT
B Settings — o
Wordfence Cancel Neod help? [2

T Smush
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G Sign in with Google

Choose an account

1o continue to Site Kit

Shannon Mattern
shannonmatterntemplatesggmail com

(@  Use anather account

To contlnug, Google will share your name, emall address,
language preference, and profile picturs with Site Kit.
Before using this app, you can review Sile Kil's

privacy policy and terms of service

English {United States) = Help Privacy Terms

Grant Site Kit permission

Create a new Google
Analytics account along
with its default property

and view
-
Deny( AIIQQ
S—
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Confirm your choices

e shannonmatterntemplatos@gmall.com
You are allowing Site Kit to:

Create a new Google Analytics account along with
Its default property and view

You already gave Site Kit access to:

. Asgsociate you with your personal info on Google

. See your personal mfo, including any personal mfo
you've made publicly available

« View your emall address
. View your Google Analytics data

View and manage Search Censole data for your
venfied sites

+  Manage the list of sites and domains you control

Make sure you trust Site Kit

You may be sharing sensitive info with this site or app
Leam about how Site Kit will kandle your data by reviewing
its terms of service and privacy policies. You can always
55 in your Google Account

Learn about the risks

~
Cancel \

&
G s G Site Kit 0 o
Dashboard -
"—Cﬁongga_t_s on completing the setup for Analytics! =9
He
fue
2n F—;‘ Search Console F ' AdSense -l Analytics ~ r:‘:;;p:ed Faa's
Media -] nrect Sorce @) ) °
» T
\ppe
& Plugine Site Overview ax1 26 days =
= All Traffic
) Ti e po lound your of
i 7] Lir
Fl se0 @

You're donellll
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Day 3 - Branding

3.0 - The Big Picture

Today you get to choose your own adventure.

A) Go through the next 19 modules and create your own brand and design your own
pages from scratch.

B) Skip the next 19 modules (all of Days 3 + 4) and customize the pre-designed brand
kit + page templates inside the Site-in-a-Snap Template Pack to match your business
and personality.

Either way, I've got your back!

If you're choosing to fully DIY, move on to 3.1.

If you're opting for Site-in-a-Snap Template Pack then after you've done the Prep,
Install, Design + Customize steps, skip ahead to Day 5.

3.1 - Canva 101

Canva is going to become your BFF throughout the process of building and marketing
your website.

Canva put together some simple, awesome tutorials you can check out here. In the
3.1 video | walk you through the basics of Canva so you'll be ready to roll when we go
to make our logo and graphics - the best way to get started with Canva is to watch
the video.
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You'll be amazed at the number of graphics and assets you need to create not only
for your website but also to market yourself online - and Canva will help you do it all
with ease.

| highly recommend signing up for Canva Pro. There's a 30 day free trial you can get
here - and you can cancel at any time.

3.2 - Colors

Install Central Color Palette Plugin

Follow my Web Design Fonts and Web Design Color Palettes boards on Pinterest
Search Pinterest for brand inspiration

Check out Awesome Color @awsmcolor for Color Inspiration

Select up to 4 colors for your palette, add to your Canva Brand Kit and to
Cen’rrol Color Palette and note the color codes on the printable Brand Tracker at the
end of this workbook.

oM~

1) Add Colors to Canva: Go to Canva > Brand Kit > Brand Colors - Click the + sign

...

Brand colors Brand fonts

Untitled palette I e 5 4 &
P Add a heading style

4 e new palette
3 Uplasd a font
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2) Enter your color codes including the #

@ Shannon Mattern Brand Kit

Create o design.

Brand logos
Horid

Al your designs
Templates
Photos

Apps

Brand fonts
| Brand Kit - = T

Design School #06164d

Add a heading style

| Add a subheading style
B3 Folders
i

W 1rash

+ Add new palette

&5 Upload a font

- @

3) Click on “Untitled Palette” to name your color palette.

@ Shannon Mattern " Brand Kit

Brand logos

A your daesigns

Templares

Photos
Apps
Brand colors Brand fonts
l Brand Kit
Design School Shan

Add a heading style

Create a team

y Add a subheading style
B Folders

W irach

+ Add new palette

Gb Upload a font
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4) Add the rest of your colors to Canva. You can add multiple color palettes.

éﬁ& Shannan Mamern - Brand Kit

Brand logos

Brand colors Brand fonts
Brand Kit
Jesign Sehonl Shannon Mattern DIY Add headin il
Create a team
=l .
[ Trash

4 Add new palette

(3 Uplead a fent

Help 2

5) Add your colors to your website. Go to Settings > Central Color Palette

CRE Rl Activate 30 days (ral

Quick Drafi

WordPress Events and News

Altend an Upcoming svent sear you. g
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6) Check the Add to Theme Customizer, Add to Block Editor + Add to Classic Editor

boxes.

+ new Pl @ UpdraftPhs Howay, Sharnan [l

Caching

Central Color Palette

Color Palette

Backup

E it
tral Color Palatie g

Import
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8) Enter your color code (the name will populate automatically if you have the
automatic names box checked). Repeat for each color. Add #ffffff for white and
#000000 for black.

- s
F Tools + ® hetive w "
@ Semings v o *x
¥
Classic Editor: Color Pickar
lumes |12« | Luma | Natural
Backup
Contral Color Palutte
Fapart

T
0o
-
[ .
Classic Editor: Color Picker
'
B Settngs Aows |8 Coturms (12~ ama | Matural ~

Backup
Export
Format | Backup
Satting
Central Color Palett
Impadt
[y} 2
1. "
o
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3.3 - Fonts

You'll need two fonts for your website - Headings and Paragraph text. | like to use the
same font for both, and use the bold version for my headings and the regular version
for my body text.

Fonts can be tricky. A font you like may not be available in Canva, or as a default font
in the website theme you choose.

If you find a font in Canva that you like, you may need to purchase it ($14-20) to use it
on your website even if it's free in Canva.

Tips:

) Choose two fonts that are easy to read and possibly one accent font.

° Canva Pro allows you to upload custom fonts - the free version does not.
° You'll learn how to add custom fonts to your website when we do theme

customization.

e Fontpair.co

e Ultimate List of Google Font Pairings (all Google Fonts are available in
Elementor Pro + can be added to Canva)

e FontSquirrel

e Creative Market

Choose your fonts and note them in the Brand Tracker.

3.4 - logo

° Ildeal size is Rectangle, start with 300 pixels wide by 50 pixels tall and adjust
based on how much space you need for your business name.

° Download from Canva as PNG, Transparent, 2x.

° Save to a folder on your computer as Logo.png.

Copyright 2020 | WP+BFF LLC | All Rights Reserved

84


https://courses.shannonmattern.com/5-day-website-challenge-2020-dashboard/3-3-fonts/
https://fontpair.co/
https://www.reliablepsd.com/ultimate-google-font-pairings/
https://www.fontsquirrel.com/
https://creativemarket.com/fonts
https://courses.shannonmattern.com/5-day-website-challenge-2020-dashboard/3-4-logo/

5:DAY WEBSITE CHALLENGE

Let’s make a logo!

Log into Canva and click Create a Design

e shanon2023 v IARR
~ TR TS
Add your picture " _
Create a design '

| Home &3

All your designs
Q. Try "Twitcl

Photos R ' k
"l wa
Brand Kit ]

Design School

- &

Choose Custom Dimensions, enter 300x50 (screenshot shows 400x100 but 300x50 is a
good start) and click Create Design.

shanon2023
o i _ v H ° shanon2023
Add your picture A

Add your picture
Create a design
| Q Search

+ Custom dimensions I 400 @ | 1 00-| px v ::‘:JD

Suggested

BA] Letter Create design

E¥ Blog Graphic

5]
L]

B> Blog Banner . Brand Kit

n Facebook Post c
@ Logo

B mazazine Cover
G) Uploads
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Click the Text icon

R Publish

Q, seorcl
Novfolle
0 e
BORABLE
T
WRITING 101

CUSTAM 5TATIONATY

= Add a new page

Click Add a Heading, (or subheading or body text. Doesn’'t matter, you'll format it in
the next step).

Al0px * 100px - Untitled Share £ Publish

dd a heading

Add a subheading

NATHANIEL
MCKEMZIE

+ Add a new page

Once you get the text added, click the font size dropdown and resize the text to fill
the white space horizontally (whatever size that ends up being for your font).
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L

Highlight your text, then click the Color icon and select whatever color you want. You
can make it all the same or mix and match colors.

< Home  Fie Res D Al

EEET

@5 add anather paistr

@ P

EEEEEE

+ Add a new page

Click the download arrow at the top-right corner of the screen.
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7 D

)} SHANNON- MATTERN

« hdld & new page

2 B W7 Help 7

Select PNG, Transparent background and 2x and click download.

Add a heading Share A2 Publish v

A Download X

F
SUGG :STED

“ Pro options

sparent background

|| Compress file (lower quality)

200 px
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Save to a folder on your computer as Logo.png (or something meaningful to you).
That's it - you made your logo!

W Desktop ] Bl L
I FFFFFF 105 Name Date Madified
el TR R
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3.5 - Favicon

° This is the icon that shows up in your browser tab.
° Dimensions are 512x512
° Download PNG, Transparent, 1x. Save to your Branding folder as Favicon.

In Canva click Create a Design and set the dimensions to 512x512 and click Create
Design

shanon2023

add your pictur

vld yaur picture

| 512 &‘:|5'|2 px v :-:_p"

Camae ]

Brand Kit

This should be a very simple design or icon because it's gonna be super small in the
tab of your web browser. You can use shapes or letters that represent your brand,
images aren’t recommended.

Click the Download icon and select PNG, transparent background and click
download.
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. —s - ]

' Download b 4

SUGGFSTED

' Pro options

ransparent background

|| Compress file (lower quality)

532 pX & 512 pX 1x (V)

{ Download ’

3.6 - Photos

Check out these amazing women, websites + podcast interviews for your photo
inspiration:

e Styled Stock Society* with Elle Drouin
o Ep. 283 - Validating Your Ideas
e Applecart Lane with Kristin Rappaport
o Ep. 221 - Starting a Side Hustle from Scratch
e Diary of an Entrepreneur with Ines Ruiz
o Ep. 303 - The Truth Behind Building a Million-Dollar Business (coming soon!)

e The Uncaged Life with Becca Tracey

o Ep.219 - How to Start Getting Clients
e Gee Nonterah

o Ep. 295 - Create and Prosper as a Writer
o Amanda Genther

o Ep. 258 - Side Hustle Sales Page Strategies
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Naomi Mdudu - The Lifestyle Edit
o Ep. 144 - Authenticity and Profit First in Your Side Hustle
Amy Eaton of Takes Pictures
o Ep. 251 - How to Stop Playing it Small in Your Side Hustle
Kyshira Moffet - The Power Collective
o Ep. 302 - Creating a Powerful Brand Strategy for Your Side Hustle (coming

soon)
Masala Body with Nagina Abdullah

o Ep.223 -How to Get Exposure and Grow Your Side Hustle

3.7 - Homepage Banner

Get photos of yourself.

Dimensions are 1400 x 500.

Download PNG, 2x

Save to your Branding folder as HomepageBanner.

In Canva click “Create a Design” and enter 1400 x 500 for the dimensions. Then click
“Create Design.

o shanon2023
L
Add your picture

2880 @ ‘ 800]

I o
Create design ’

Brand Kit

Click Uploads to upload images of you to use in your banner.
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< Home File Resize

Uploadan‘lmage

Navigate to wherever you have the image saved on your computer and click “open.”

¢ == B Imsges z a &
. Favsttien '
— W oEm
| iy . i
O Downioad
12 “nanne 0E-0RIEWE  0IE-OGIEWE  I0TE-DGIE WP AbcutShannon  Buliavieosiio on n
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Once your image is uploaded, click on it to add it fo the canvas.

£ Home File Resize All changes savad

Click and drag it to resize it and fill the canvas (this is why the images of you should be
wide with you off to one side).
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Or you can use the Background Remover in Canva Pro to remove your background
image:

Effects  Filrer  Adjust Crop  Flip Position 3 & @ [‘E m

Background Remaver
!

]

5]
9 -

weth ane rhick

o You may also like
Bad TV
= ATy td T Miects 1o your mn
|1
| Calor Mbx
- ALE ¥ coka o
ﬁ Glitch
_ Aty bt s
[>] g

A Download X
File type
PNG v

Pro options

_| Transparent background

Compress file {lower quality)

2880 px lia 800 px 1% iV
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Day 4 - Website Design

4.0 - The Big Picture

There's still time to choose your own adventure!

A) Follow the next 12 modules and design all your pages for desktop + mobile from
scratch.

B) Skip the next 12 modules and install customizable pre-designed page layouts in just
a few clicks with website copy prompts throughout the pages inside the Site-in-a-Snap
Template Pack.

Either way, I've got your back!

And if you're looking for trainings on the themes | used to teach in earlier versions of
the Challenge (Make by Theme Foundry and Divi by Elegant Themes), check out The
Vault for all my past frainings.
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4.1 - Elementor 101 + Elementor Pro Installation

1) First, we’" insta" the He"o # Elementor Tutorial B8 4= Mew Cac
» Lomments
Elementor theme.

B Elementor Disable Default Colors

Sattings

Go to Appearance >
Themes

Disable Default Fonts
Improve Elementor

Usage Data Tracking

= Templates

= Forums
% Topics

#% Replles

Users
Tools

i Settings

2) Click “Add New Theme"

mes | WaordPress arg Thi

Digital strategy for
LIM(LIE amall businesses
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3) Enter “hello elementor” in
the search field, and the
theme looks like this:

Add Themes sk s

Hello &
I * Z

Hisk el

4) Click Install

# Elementor Tutorial §9 4 New Caching

Add Themes Upload Theme
o Faatured Popular Latest Favorites  Premium
71 Media
y | - | =
Pages — a .‘ ™
mMelo "
Comments Lol
Details & Preview
2 Forums
% Topics
Replies
2 Appearancae \\I
Helio Elementor { m | Preview
\ /
Themes e -
5) C||Ck ACT|\/O1’e or Tutorial @8 < New Caching
1] =
a8 Bluehost Add Themes | upload Theme
& Jetpack
R Dashboard o Featured Papular Latast Favarites  Premiun]
Posts
= | ¢ Installed
41 Media
s Hello
Comments Theme
= Forums
[ =]
% Replies
Appearance 7 \_\
Hello Elementor l\ ) Live Praview
Th i
emes  —
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6) Install Elementor Plugin:
After the Hello Elementor
theme is installed, a
message will pop up
thanking you for installing
the theme, and will invite
you to install the Elementor
Plugin. Click that button to
install it (or you can search
the WordPress plugin
directory for “elementor”
and click install.

Themes @B

cornbare ks || Wertivass g Therves || Uphe || | S intaliod Tiame
Tharks for instaling Hell Theme! —
et e i FOATReScUT SABITE Ihesn. W CROORTYTEN Y0 L5 K Jogeiins wilh Eksmanian Swge Bibder phagin, ey work peciecty sgerren |, [T

7) Once you've installed
Elementor either with the
button or via the plugin
directory - you'll land on this
page, and then click
Activate Plugin:

Installing Plugin: Elementor Page Builder 2.6.5

Unpacking the package...

Installing the glugin..

inug\.{:ﬁ the plugin Page Builder 2.8.5

3
\'\_\_ ’/'

Dowmloading installation package from htEps: //domnloads . wordpress . org/plugin/elementor, 2.6, 5. tp.

8) Install Elementor Pro - Go
fo
https://shannonmattern.com
/elementor (affiliate link)
and click on *Pricing”. Then
click “Buy Now” under the
$49 option.

49,

EXPERT

“199..

For 1 Site For 3 Sites

Faor 1,000 Sites
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9) After you complete your
payment, click Download
Plugin and pay attention to
where you save it on your
computer. You don’t need
fo copy your license key bc
there’s an automatic
connection process, but you
can always get it in your
Elementor account just in
case.

Do Everything
With Elementor

Welcome to your sccount page,

Hera yoarll b able to see your purchase detalls, downlosd the phagin and get your license key for the plugin activation.

Ftan Plus | $74.25 Yearly
ety oo
MMMM st na 71 Tnen ST

<199
r—an}'(mPoF;ﬁ—Js- 510 /year

(!

S Chibngabg WEE1E]

10) Next we'll upload the
plugin to your website. Go to
Plugins > Add New

& Dashboard

Plugin activated.

& Plugins

Bulk Actions 5 Apply

lled Plugins

Plugin

Ajax Search Lite

Dimantirats

Al (8) | Active (6] | Inactive (2) | Must-Usa {3} | Drop-ins (2)

Description

The lite version af the m)

Simpli

Jetpach

unlimity

Activat|

powerfi
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11) Click the Upload Plugin
button, then click Choose
File:

Add Pluging| upesd sugin | )

It you have a plugin in & Zip format, you may install it by uploading it here.

12) Navigate to the
Elementor Pro plugin
wherever it saved on your
computer, click on the file,
and then click Open. (Note -
I'm on a Mac, if you're using
windows this will look
different for you).

) Favorites
3+ Dropbox

L © oonnloads

! {2} shannon

Dasktan

| \
| m

5 Day Challenge Carvertkit Google Sita kit ImageCiptim app |
Graphics 2019 Wiahinar Banusas hpo-2814 7p Scrasnshots

13) Then click “Install Now”

Add Pluging  usiasa stugin

W you hawe & plugen na zip format, you may install it by wploading it here,

v A ElEmentar-pra-2.8.14.zip
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14) Click Activate Plugin

# Elementor Tutorial B 4 Mew Caching

BN Installing Plugin from uploaded file: elementor-pro-2.5.14.zip

Unpacking the package..
instatling the plugin...

Posts Plugrriretatied.successtully.
I
0y Media W Activate Plugin

N -

| Return to Plugin Installer

Pages

Comments

E Elementor

15) Next we'll connect our
Elementor license. Go to
Elementor > License:

# Elementor Tutorial B <4 New Cachi

Bluehost Bulk Actions 5 Apply

Jetpack

Plugin
8 Dashboard

Ajax Search Lite
Posts Deactivate

Media . "
Akismet Anti-Sparl
Pages Activate Delete

Comments

Tempiat_e;a \ Custom Fonts
\ Role Manager

Forums Toals

Topics

Replies Getting Started

Help

» Appearance

Plugins

16) Click on “Connect +
Activate”

[ 4 Mew hing

License Settings

Activate License

Please activate your license to get feature updates, premium support and unlimited access to the
template fibrary.

B Comments
¥ C 4

H Elementor

tings

Y
Connect & Activate ‘I
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16) Click Connect

shannon@wp-bff.com
elementor.scarlettmattern.com

Connect & Activate Your License

Y b
‘Hﬁ"'"—h___‘_ d__—---""'/

——

17) You should see a green
Active status, and you're
done!

T # Sementor Tutorial B 0 4 Mew
License Settings
| status: Active

You'ra connected as shannondiwp-=bif.com. ‘Want to activate this website by a
different license?

Want to deactivate the Bcense for any reasan?

My Aceount

Switch Aceount

Desconnect
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4.2 - Elementor Setup

1) First we'll add our
Logo + Site Icon

Go to Appearance >
Customize

WY @& Shennon MattemDIY <1 B

@& Dashboard

Homs

Updates 1
G Site Kit
EEE Bluehost
A Posts
01 Media

B Pages

B Comments

Elementor

Templates

i Plugins @
Usars

* Tools

Settings

SEQ &

+ New A 2

Coming Soon Active
WordPress Updates

Lost checked on May 11, 2020 at 9:38 am.

You have the latest version of WordPress. Future s¢

i you nesd to re-install version 5.4.%, you ¢

notall Now

Plugins

Your plugins are all up o date.

Themes

Your themes are all up to date

can do sa here

Caching Updrai

Check Agaln

2) Click Site Identity

X

You are customizing

Active theme

Hello Elementor

Site Identity

Menus

Homepage Settings

Additional CSS

Published

Shannon Mattern DIY

Change

Shannon Mattern
DIY

DIY Web Design + Marketing Training

Home
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3) Click Select Logo

x
Customizing
Site Identity
Logo
act Inga
Site Title

Shannon Mattern DIY

Tagline

DIY Web Design + Marketing Training
Site lcon

Site fcons are what you see in browser tabs

okmark bars, and within b
r gpps. Upload ome

WortPress

Sire kcons showld be square and at feast 512

x 512 pixels

Selact site lcon

Shannon Mattern
DIY

DIY Web Design + Marketing Training

Home

4) On the Upload File
Tab, click Select File

Select logo

Uplnad Fles  Mtlis Library

Drop files to upload
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Salect logo

5) Navigate to where
you saved your logo
on your computer
and either
double-click it or
click Open to upload
it to your site.
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6) Click Select

7) Drag the bars
around the image to
crop out the extra
white space and
click Crop Image
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8) The page will = m L) B G ik A
refresh automatically ||« seeem
and your logo will
appear.
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9) Click Select Site
lcon

]

Home

O .

10) Click Select
Image
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10) Click Select

Image

11) Navigate to O e e , T
where you saved M o T e m—
your Favicon/Site : e o 0

lcon on your ; Home

computer and either
double-click it or
click Open to upload
it to your site.
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12) Make sure your
Site Title and Tagline
are what you want
them to be.

=B o O o

Home

13) Click Publish
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14) Click the back
arrow

ER L) O .

Home

15) Click the X to go
back to the
WordPress
Dashboard.
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Elementor Settings + Fonts

In Elementor >
Settings on the
General Tab, check
the Pages, Posts
Disable Default
Colors + Disable
Default Fonts boxes.

On the Style,
Integrations +
Advanced Tabs - no
changes.

i Elementor

OQenoral | Style  Inlogrutiens

Paat Typas
Disalse Defaule Calors
Digabin Dnfauds Fonts
Imprewe Eldmeantor

Ussge Data Sharing

¥} Chacking this bas will st

7 Ghuscking fhie box wil

Elerrartor's Delau® Colors, rd neake Elamendar inarlt the calees fram yeur thems

disadle Elemertor's Defaul Forts, ond make Elementor inherit the Fomls

In Elementor > Custom
Fonts, if you
purchased or
downloaded any
custom fonts, you'll
add them here.

Click Add New

AILTI | Futished (1

Custom Fants e | |

Enter the name of
your font and click
Add Font Variation

i Add New Font

| Enter Font Family

Managa Yeur Font Flas
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Look at the file
extension (the part
after the period) on
font file you have,
and then click upload
on the corresponding
file type in this list. If
you don't see it, for
example, your file
ends in .OTF, then use
https://cloudconver

t.com/ to convert
your font file to one of
the types listed here.

Add New Fant

Wild Spirit

Manage Yeur Font Flas

Pubish

Upload your font file
to WordPress and click
Select

Upload fant ttf file
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Click Publish.
Repeat for any St oo
oy Wild Spirit Prilish =
additional custom . e e ()
fonts you purchased . — T '
or downloaded. .:
m
2 m
)

Go to Settings > :
Central Color Palette i i i
and check the box to B
integrate with
Elementor

fFE am
T

¥ Automatie Names

There are no changes to any of the other Elementor settings!
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4.3 - Global Theme Styles + Header

As you move through the modules 4.3 through 4.9.2, | highly recommend that you

watch the videos because even though I've documented everything in writing here in
the screenshots, there’s a lot of strategy that | talk about in the videos plus techie tips
and tricks | show all along the way that will save you time and teach you A LOT more
than | can show you in words and screenshots. But you can use this as a reference to

support the videos.

In this module we'll create the Header of our site that has our logo and navigation
menu and set that up to display automatically on every page, and we'll also set

global theme styles, like colors, fonts + buttons.

Create Header: In
the WordPress
Dashboard, click on
Theme Builder >
Templates.

#3 Elementor Tutorial

Bluehost
Jetpack

¥ Dashboard

Posts
47 Media
Pages

Comments

Elementor

= _"_I'empla;t"gjst >

Saved Templates

Add New

Categories
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Then click on the @ @ Elementor Tutorial B 0 4 New Caching

Header Tab, and then | i " /"' e,

i Bluehost Theme Builder | Add New )
. anm \ ew | Import Templates

click Add New. \__
@ Jetpack —
4 Love using Elementor? Become a super contributor by opting in to our ano
@& Dashboard 9 P y a

Sure! I'd love to help No thanks
A Posts
D,J Media =
I//_ _"‘--.\
M Pages Theme Builder ~ Loop | Header) Footer  Single  Archive
¥ Ccomments
= All {(5) | Published (5
Elementor = ' i
Bulk Actions § @ Apply Alldates ¥ All Categories ¥ = Filter
& Templates
_ Title Type Instances

Say emplates

Enter Header for the
name and click
“Create Template”

& rew remeuate

Choose Template Type

Templates Help You Shloctthe typm f 1 e you want 1o weick on
Work Efficiently aadr

Haadar |

You can use one of
Elementor Pro’s
premade templates,
but we're gonna - - e B
create our own. Click
the X to close this

PopUP.

Helu
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Click the + to create a
new section.

@0

Select this 2 Column
Structure

w

Header

Click the 6-blocks in
the left-side menu.
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Then click and drag = e
the “Site Logo” block
to the far-left column
of your header:

0

{eader

Click on the Column CENCTENT
icon in the column — -
where you just put '

your logo. 00

{eader

Consert Area
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Enter 40 in the column
width field.

{eader

o

Click on the Style icon

{eader

sl
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Enter 20 in the top +

bottom margin e it
00
: rleader
Click on the @ comeiw ]
hamburger (three
lines)
00
* reader

Click on Theme Style.
In this section we are o
setting Global theme
styles for your whole 00
sife. You can access
the Theme Styles from
any Elementor page rleader 2
on your site, not just .
your header. But since m

we're working on the
header first, that's why

we're going in from | [T
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here to set up the
global theme styles
NOW.

Click on Typography

Background
Ko tiie ) Header
R Content Area
In the BODY section,
Click on the pencil
. + Background
icon, select your °
aragraph text font. ~ Typography
paragrap Header

| recommend leaving
the default text color
for readability.

Set the size to
somewhere between
14 and 20 depending
on your font (it needs
to be readable) and
adjust any other
settings you want to
adjust. Click off of the
typography style
window, and the
update button will
change to Blue. Click
Update often to save
your changes.

Body
Content Area

Text Colar

Typography

Farnily Montserrat

Weight 300

e (_ UppATE )=

Copyright 202|
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In LINK, change the
color to your brightest
color and click the
pencil icon to set the
font + font size to
match your
paragraph text - but
make the Font Weight
BOLD.

Typography

Link

Caolor

Header

Content Area

Privacy Pelicy Terms + Conditions Copyright 2020 | Shannon Mattern |

Set Header styles for
H1, H2 and H3. H1 -
should be the biggest B Header
+ boldest, H2 should S
also be big and bold, _ "

= W 1. Click on the Color box to set your heading
and H3 can be an colors (you'll see the colors you added to

Dmogia Central Color Palette in the color choices)
accent font that you
use sparingly (like, for -
just a few words that A1 s Bl e ey Susioesfante pee
H A Wikl Sipiit uploaded at the top, and the rest of the list is
InTrOduce anew | all the Google fonts available in Elementor.
section bc they are o
harder to read). You

can set styles for
H4-Hé6 but you're
probably never gonna
use them.

Privacy Policy Terms + Conditions Copyright 2020 | Shannon Mattern | All Rights Reserved
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Style your Buttons.
Click Update to save
your changes.

In Form Fields, you can

set the Typography to
match your Body text
(or you can leave as
is).

In Images, there’s
nothing to change.

+ Background

Header

| = Buttons |

Content Area

1. Click on But

After you've clicked
Update to save your
global Theme Styles,
click the X'in the blue
panel to exit the
global theme styles
and go back to
editing the Header.

¢ Background

e Header

¢ Buttons
Content Area

¢ Form Fields

=~ Images

You can get to the Theme Styles panel from any page, it
doesn’t have to be the Header - just know that any
changes you make in the blue Theme Styles panel are

global changes, whereas changes made on the red panels

are specific to that page or global theme element (like
headers and footers).
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Next we’ll add a menu
to our header. Click
on the blocks in the
red panel, search for
the “Nav Menu”
element and click
and drag it to the
right-hand column of
your header.

rleader

Content Area

Header

In the Content tab >
Menu section, click
the dropdown and
select your Main
Menu (if it's not
already selected).

----- - reader

In Align, click the
“Right” icon.

e

- reader

bout Blog
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In Pointer, click the
dropdown and select
None.

i

- Header

To see what your
menu will look like on
mobile devices, click
the computer screen
icon in the black
section at bottom of
the styles panel. Then
select “Mobile”

s o L=

.

reader

" Content Area

Elementor will show
you how your site will
look on a phone and
you can make any
adjustments needed.
You can do this on
any page, and you'll
want to do it for
Mobile and Tablet.
Click on Desktop to
get back to the main
screen.
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Click on the Styles
Tab. This is where you
can set styles that
override the global
theme styles you just
set up if you want.
They will apply only to
the selected element.
For example, in this
screenshot I'm
changing the Hover
color to tan. You can
change the color on
mouse-over (hover)
and on the Active
menu item (page
they're on). There's
nothing to do on the
advanced tab.

When you're done
making changes,
click the green
Update button. Then,
because this is a
global part of your
theme, Elementor will
ask you where you
want to display it.
Choose Entire Site,
and then Save + Close

Where Do You Want to Display Your Revision?

To exit the Elementor
Page Builder, click on
the “hamburger”
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Then click on Exit to < el P
Dashboard

GEOBAL STYLE
Default Colers
Default Fonts
Theme Style

e 00

DOrag widget hera
Global Settings

Dashboard Settings

About Elementor

o Header
it Content Area
Finder
[ e ]
And you'll find yourself | S EEIE

Edit Template _Asinn

back in the regular
WordPress dashboard,
on the WordPress side
of the Header
template, and able to
get to all things
WordPress.

Header Publish

£ Back 1o WordPress Editoe

Edls with Elamancr

Featumed image

Now you know how to:

Set global theme styles.

Create global theme elements, like a header.

Add sections + columns and elements to pages.

Make adjustments for desktop, tablet and mobile.

Tell Elementor where to display global elements like headers and footers
Exit the Elementor page builder and get back to WordPress.
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4.4 - Footer Design

The footer is the section that displays on the bottom of every page of your website and
typically has a copyright notice, links to privacy policies + terms and conditions, and
anything else you want to have show up on every page of your site.

I'll show you how to make a menu that displays your Privacy Policy + Terms and
Conditions pages and show you how to add other elements to your footer (and make
sure everything looks great on mobile devices).

And you'll be learning even more about Elementor as you go!

First, we'll make a
footer menu. In your
WordPress dashboard
go to Appearance >
Menus and click
Create New Menu

Name it Footer and
click “Create Menu”
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Click the View all tab
to see all of your pages

Edit Menus  Manage Locations

and check the boxes = st s s | Pt ] | o s s o o i e g
beside your Privacy w e o s
Policy + Terms + >
Conditions pages. Click | EsEss i
Add to Menu.

A ez

Click Save Menu.

Edithenus  Manoge Lscatisns

>
mct momans to et | Footir - Salmri | or pam 1 mumy. Bon'l forget tn sem your cuges!
L]
L]
Add mens tems Menu structure
(v} ]
N . " s |

Srivary Palizy

Tesms + Comdtians

Menu Settings

by e rew top-bevel gages 1o this e

Now we're going to
create our Footer. Go
to Templates (1) > il
Theme Builder (2) >
Add New (3). Select
FOOTer from The . = Templates Help You
Dropdown and name it | [ Work Efficiently
Footer (4). Then click ~—
“Create Template” (5)

Choose Template Type
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Click the + sign ETE

Footer
Content Area

g wecges e

Select the 3 equal

columns
B m
EEEERY 7]
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Click on the 9 blocks,
find the text editor
element and drag it to
the first column.

BN ooter

. . Content Area
= )
i .
i ([ =
) - Dha it
[&] L

Find the Nav Menu
element and click and
drag it to the center
column

EREFooter

Content Area

i Lorem ipsum dolor sit amest. consectatif—__
adipiscing elit Ut elit tallus, luckus nec
ullamcorper mattis pubdnar dapibus

» oo

T 00
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Use the search bar to
start entering “social
icons” so that you
don’'t have to eyeball
search for it. Click and
drag Social Icons to the
far right column.

R ooter

Content Area

Larem |psum doler sit amet, cansectatur o o
Privacy Policy

adipiscirg ellt Ut elit tellus, luctus nec

ullamearper mattis. pulinar dapibus Terms « Conditions

lec

.o

Now we're gonna
customize each
element.

Click on the Pencil Icon
of the Text Editor, make
sure you're on the
Content Tab, and then
edit the text to say

Copyright 2020 | Your
Business Name | Al
Rights Reserved

Save your changes

= EdA Tawt Ediine

wFooter

2. Click the pencil/edit icon

Hyry,-rigmzozm Your Business Nanje B | Privacy Poliey Bun
All Rights Fesered — i
Terma + Conditions
4. Update often ° o
T S —
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In the Text element,

click the Style icon and (L8 ) <% comoncien
make your text smaller. e
n.‘;f:-llﬂlr'ﬂ.l iI:HS elament
00
Click the pencil icon on iFooter

the Nav Menu. Make
sure you're on the
Content Tab. Select the
Footer Menu, and latch
all the other settings to
the screenshot.

Miolsle Dregubemn

Content Area
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On the Nav Menu
element, click the Style
lcon and adjust the
text size, etc.

shod

Click the pencil on the
Social Icons, make sure
you're on the Content
tab. Click the X to
remove any icons you
don’t use. Click on
each item to expand it
and add your social
links. Change the
shape and alignment.
Click the Add Item
button to add any
accounts you use that
aren't listed.

e A e weent | Content Area
———==—. Makt sure you'ra;on
+ secsone EhO Content Tab

Do whip frerm

1. Click the pencil to
edit the social icons

000

©o
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Search the list of icons
for your social account,
click the icon and click
insert.

To style the icons, click
the style tab and
change the color, size,
efc.

Click update to save
your changes.

000
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siFooter
’ L] L]
Content Area
[
T o0

Save your widget as a global widget
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{ i )
SS=————"Content Area
You can access all your global
to add them to pages
i = by click the Glabal tab.

Sreaan T4

You can tell it's

it's yellow.

aur Bire s bame | &1l Big

000

When you'r clnte

Drap migee e

o

ve your changes

Footer

Content Aroa

en yau click the yellow pencil on a global
ment, this sereen will pop up aski
ant the change:
applied globally

vou If you
1 make to the widget to be
ywhere the widget is used

Your Widget ks Mow Locked (EDIT)

ot If you want to
and make ind
the widge

| widget
1 on't affect
on other pages. (UNLINK)

No right or wrong here « just a decision on how
you wani your changes to be applied

NI

000

0o

Drap e e
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When you click pE—"
Update, you'll be
asked where you want
to display your Footer.
Select “Entire Site” and
Save + Close.

Where Do You Want to Display Your Template?

You're done! Now you know how to:

Add elements to columns.

Search for elements.

Style elements.

Save elements as global widgets that you can re-use on other pages (we'll
re-use our social icons on our Blog sidebar so that if we make a change to it in
one place it will be made everywhere).

4.5 - Perfect Homepage Layout

Your homepage layout is the secret to a website that converts visitors into subscribers
into customers. | recommend watching this training because In this video I'll break
down the components of the perfect homepage layout and show you some
examples to inspire you as you start building your own.

The sections outlined in the video are:

e Banner with Irresistible Call to Action + Your Picture
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Call To Action to get your freebie + email optin form
Intfroduce yourself

How | can help you

From the Blog (opftional)

Final Call to Action

Watch the video for inspiration!

4.6 - Homepage Design: Banner Section

Now that we have a global header + footer created, and we have global theme
styles set up, it's time to create our first page.

You'll learn how to convert a regular WordPress page to an Elementor Page, get the
header + footer to show up on it, and add sections + elements to your page.

In this module specifically, you'll create a banner section and add your banner image
and text so that every visitor to your site immediately sees what's in it for them as soon
as they land on your homepage.

Go to Pages > Home
and click on Edit.

W & Shannon Mattern DIY O L] + MNew EMA Caching UpdraftPlus

@ Dashboard Pages | Add New-_
G site Kit All (8] | Published (8) | Drafts (2) | Cornerstone content (0)
# Posts | Bulk Actions v || Apply | Alldates  ~ || All SEQ Scores b4 || Al Readtan|
) Media | Title

|. Pages )

"] About— Elementor

All Pages

Blog — Posts Page

¥ Comments
| Home — Front Page, Elementor

B Elementor Edit |<1L|ck Edit Trash View  Edit with Elementor
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Then click the blue Edit
with Elementor button.

.
[ viewpugee |
Home

G.)

Click the Gear
lcon/Settings in the
bottom-left corner of
the screen.

oo
- 000
Click on Page Layouts
and select Elementor .
Full Width. The page o Home
will refresh.
o
i . 000
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e walipat hare

Qeo

Select the single
column layout

AR 0o0
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Click the 6 dots on the
section, make sure
you're on the Layout
tab and set the
Content Width to Full
Width, Height to Min
Height and Minimum
Height to 500

00
Click the Style Tab >
Background and click 2 (8) .2
on the paint-brush .
icon, then click on the —
+ sign in the Image - ~ s
ox. LA _
i)
o) 0o
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Navigate to where you
saved the banner
image we created on
Day 3 and click Open.

e ¢

Then click Insert Media.

— s,
(= — W —— _ ?

- — ] i

a : =5 S | LT
—— b . [

| @— = Q,w i
- Capaskphenas T lﬂ = s
THIGE ait. e Ed g
Pl 8 Gnlns P
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In Position, choose
Center Center,
Attachment > Default,
Repeat > No-Repeat,
Size > Cover

Right click (or
two-finger click on a
Mac) on the column
icon and click “Add
New Column”

Right-click (two-finger click
on Mach on the column icon
T~ and click Add New Column

......

Home

About

alog
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Now you have two

columns and you can e | -
click and drag to o
change the column it o TR s _
. Click and drag tha line between the
WIdThS. toursl pie % Getuh r columns to change column widt\hs.
.n-,.-.-m..:“- - '\\

Click on the 9 blocks,
find the Heading :
element and click and

Heme  About  Biog

drag it to the left-hand = (1)
column you just ——
created. || = i =B
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On the Content tab,
change the text to
what you want it to
say, change the HTML
tag to the Header that
you set in the Global
Theme Styles to set it to
use the font style, color
+ size you want to use,
and align it Center.
Click the Style tab to
make any adjustments
needed to size, color,
etc.

To see what the page
looks like full-screen,
click the red tab to
expand your page.

’ © B SiF
Thie

. : :

= Bl

...... I \
)
\{__/'
2 =
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Click the grey tab to
see the panel again.

Click on the 9 blocks
again, find the
Heading element
again and click and
drag it below the one
you just added.

Update the text,
change the HTML Tag
to the header you
want to use and

change the alignment.

If you want to change
anything else, click the
Style tab and change

the color, font size, etc.

Bl = bt

in just 5 days
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If you need to change
the spacing between
the two elements, you
can click on the chain
icon in Margin, and
then click the down
arrow in the top
margin to move the
element UP.

Boell o vl
in just 5 days

55 Dlmses

+ Mmspmsbee

Continue to add
anything else you want
to your banner, edit it
in the Content tab and
Style it in the Style Tab
and adjust the
spacing, etc. in the
Advanced Tab.

When you're done,
publish your changes.

. ng(a{ o welple

in just 5 days

[even Ifyou're not techia)

4.6.1 - Homepage Design: Page Sections

We'll add the rest of the sections to finish up your homepage (and you'll be learning

even more about how Elementor works as you gol)

Copyright 2020 | WP+BFF LLC | All Rights Reserved

149



https://courses.shannonmattern.com/5-day-website-challenge-2020-dashboard/4-6-1-homepage-design-page-sections/

5:DAY WEBSITE CHALLENGE

Click the + sign to add
a new section below
the banner section.

I

Bl el

in just 5 days

|even if you're not techie)

2=
(@0
o o = - - NS
Choose the single m
column structure.
gml:{just S’I;ﬁ
|aven if you're not techis)

[en. =« |

o = = - - NS
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Click the Advanced m

fab, and set the

padding to 50. - ng{c?{ w%#ﬁ
Ve in just 5 days

{even if you're not techie}

' Ruzemeren

00

| > o - - -
Click the 9 blocks, find | [FEEE—

the Heading element —
and click and drag to : : 0{ :
; - ot (4% %

the column section. = | (T 'y

TS T injust 5 days

) LS \‘\ {even if you're not techia)

AE N

+ o1 e

ﬁ :3;\ = S =

o= w s
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On the Content Tab,
edit the text, change
the HTML tag you want
to use and center your
contfent.

Click the red plus sign
to add a new section.

in just 5 days

{even if you're not techie)

TR T i

et o Stop struggling and finally get your website online!

00

Click asingle column
structure.

i in‘jhst 5 dayg I

lewen If you're not techie)

e

= =
s Tt Stop struggling and finally get your website online!
3 ol
=
" - SELECT YOUR STRUACTURE
wegl W
B i
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Click on the 9 blocks,
search the elements
for *shortcode” and
click and drag the
shortcode to your
column section.

B 2z08 ey crategs weon. x T - AAT-HamaDagE DegR R X |
& © & shannormatteendy. com/wp-ad mispost phpTpasts 113 SRR st sl smantare T Gl ® s Ga B il
[ Oitae Bemen

4r BN Arcsiamr. (D Grosikidl BN PTASH BN MEAC @ GoogeDeve @ SUWC UL Cursti [N 0S0IMC Omel BN FGenmLinks
G s | '
in just 5 days

leven if you're not techie)

Efapﬂgyggling and finally get your website online!

s e L |

00

ey et oo

Enter

<div
align="center">[conver
tkit shortcode goes
here]</div>

In the shortcode
section and click

Apply.

Click the red plus sign
to add a new section.

leven if you're not techie)

Stop struggling and finally get your website online!

00

ki eyt o

000

Copryright 2000 | Shareon Mattam | Al Bights Resrand
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Click the two-column
section.

I L
P - |

lewen if you're not techie)

Stop struggling and finally get your website online!

- - - - -
Click on the Advanced | FEEEEEEESE] fevn youre not ectie
tab and enter 50inthe | | & =)

padding section.

Stop struggling and finally get your website online!

00

Dy iefeed e
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Click on the 9 blocks,

B 2z08 ey crategs weon. x e Wi b * AbT-HamIDaE D e X |
. . [ © & shannonmatherngdy.com wp-ad minpos phpTpests 1358 Eartins sl smantare * AT Ga TR
find the Heading and Aoy e p——— . A
click and drag it to the = Aw vl N
first column. Stop struggling and finally get your website online!
== 1
00
i el Firng ey o
B= iz
g L Coegright 2000 | Sharman Mattam | A1 Rights R OQO
Find the text editor and el [— B ——

drag it below the
Heading.

== 1
Add Yo

Cpr

[ (3]

e

orslemantore

5 [ MEIC § GopeDevs @ S0ws O Ceere B As0EmWE s BN R Geip Links

A -

Stop struggling and finally get your website online!

= ing Text Here

00

g eyt hero

Copyripht 2020 | Sharnan Mattem | A1 Fighis Reserved

¥ RATO L Ga 0
v

» g

lalela)
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Find the Image
element and drag it to
the right column. Click
on Choose Image and
select the image when
you want to display in
the section.

v inaze Stop struggling and finally get your website online!

Add Your Heading Text Here =

Larern igsum daler sit amet, consectetur adipizcing eliv
Ut alit tellus, luctus mec ullamcorzar mattis, pulvinar
daplbus len

-tz Stop struggling and finally get your website online!

TR BLad vour Heading Text Here

Lorern ipsum dolor sit arnet. consectetur adipiscing elit
Ut elit reflus. luctus nec ullamcorpar mattis. puhinar
dapibus leo,
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Click the red + sign
again and add a 3
columns section

Ut elis teflus, luctus nes ullameorper mattis. pulvinar
dapibus leo,

Drag an image to
each of the 3 columnes.
Edit the image boxes
to add your images.

Drag a heading to
each of the 3 columns.
Align it center.

Drag a text editor to
the first column. Align it
center.

Ut elit teilus, luctus mes ullamcorper mattis, pulvinar
dapibus leo

“ el ® CE
. B i Group Links D Ottwe Brocn
m
- \-..
| 1!
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You can duplicate
sections by
right-clicking on the
pencil icon and
clicking duplicate

= Edit Tt Edilioe

/; L &

* Toxt freew

Add Your Heading

Add Your Heading Add Your Heading

Text Here Text Here Text Here
- - - - - E— Y.
Then you can click and P— B —
i G AT @ A
drag and drop the g Tt -
new section to any R —

other section on the
page.

Continue to add
whatever sections,
columns + elements
you need to add to
your site.

Use Padding and
Margins in the
Advanced Tab to
adjust spacing
between elements.

Once you've added
all your content to your
page, click Publish.

Add Your Heading
Text Here
Lorem ipsurn dalor sit amet consectetur

adipiscing elit. Ut et tellus, |Lctus nee
ullamecorpar mattizs, pulinar dapibus

Add Your Heading
Text Here

Add Your Heading
Text Here

Copyright 2020 | WP+BFF LLC | All Rights Reserved

158




5+DAY WEBSITE CHALLENGE

4.7 - Mobile-Responsive Settings

Adjust your page design so that it looks great on any device! You'll go through every
section, column and element on Mobile + Tablet and adjust them to look the way you
want. Anything that has a device icon beside it will just be changed on that device. If
you change a setting that DOES NOT have a device icon on it, that change will be see
on all devices (like text, number of columns, etc.)

Click on the
1" . s L1] -]
computer/"Responsiv i I
e Mode" icon s
W‘ e
e

Click on Mobile to see
all the mobile settings
for each element

“ Bull < b

in just 5 days
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Any element that has
a device icon beside
it can have the
settings on it changed
and the settings will
only show on that
device. So you can
click on any section,
column or element
and see what can be
changed on mobile.
In this example, |
clicked on the 6 dofts
for the whole
section...

finally gt
your website
online!

Add Your
Heading Text

Here

And I'm changing the
padding to 10 (it was
50 on desktop, so
changing it to 10 gets
rid of the extra space
around the element
on a phone).

finally gt
your website
online!

Add Your Heading
Text Here

Larern ipsum dalor sit amet,

consectetur adipiscing efit Ut el

tellus. luctus nec ullamcorper
mattis, pulvinar dapibus leo.
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You can also adjust
how the site displays
on a tablet by clicking
the Responsive Icon
and then Tablet.

finally get
your website
online!

Add Your Heading
Text Here

Lowern ipsum dotor sit amet,
consactetur adipiscing elit Ut elic
tellus, luctus nec ullamcorper

mattis, pulvinar dapibus leo

Again, any element
that has a device
icon beside it can
have the settings on it
changed and the
settings will only show
on that device. So
you can click on any
section, column or
element and see
what can be
changed on a tablet.
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bae
in just 5 days 8

(even if you're not techie) ,J

..........

Stop struggling and finally get your
website online!

-----

Go through your homepage on desktop, tablet and mobile and adjust anything you
need to adjust to make it look good on each device. Then publish your changes.
You'll want to get all your mobile settings right before moving on to making your next
page, because we're going to save this page as a template and re-use parts of it to
save time, so you'll want to have everything neat and tidy before you make it a
template in the next module.

4.8 - About Page Design + Cloning Pages

You'll learn how to clone page layouts you've already designed to make new pages
and save yourself a TON of time. Again, | recommend watching this video to see alll
the ways you can edit page layouts with Elementor (even though | have a list of them
below). Seeing it in action will probably make more sense!
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To make our About
Page, we're gonna
save our Homepage
as a template, and
then apply it to our
About page and then
edit, add and remove
stuff to design our
About Page.

So click the little arrow
beside the update
button and click
“Save as Template”

Give it a name
(doesn’t matter, just
make it meaningful to
you) and click Save.

Save Your Page to Library
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Close out of the list of
your page templates
(you'll only have the
one at this point).

Then click on the
hamburger in the top
left corner of the
screen.

Then click Exit to
Dashboard. That's
how you can save any
page layout (you can
even save sections)
that you've made as
a template you can
re-use on other pages.
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If you see this page,
click on the W to get
back to the list of
Pages in the
WordPress dashboard.

(If you have the
Classic Editor plugin
installed you won't see
this page.)

Desument  Sock

Starun B viskibty

Home

Purmaiine

I o i Elermontor Fratured mage

Page Atwibules

AT AT O s (7 o Iy ieaage

Find your About page
and click on the Edit

”n k. ANdates | | A)SED Scores w || NI Resgatiy Scorer e || Sl Shama
Aulhar i o @4
e bat—Elementor . Gramm P
‘;!"‘ - .
5 e - _—
C“Ck Edit with » B = m e 1o I
Elementor R :
About R
! @ _—
Foge Atiribiies v
Click on the grey = e o
foldericon
About
-
0';0,__'
Gopyright 2020 | Shannon Mattorm | Al Rights Resored {:} @ O
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Click on My Templates

Find the template you
just created and click
Insert

Choose YES to import
document settings.
What this does is set
the page to be the
“Elementor Full Width”
page layout. If you say
No, then you'll just
click on the gearicon
at the bottom of the
page to change the
page layout to
Elementor Full Width
like you did when you
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made your
homepage.

This is what your About
Page looks like once

the template is -
applied - exactly like =171 j
your homepage. F B

So now, you can edit

itl Here are all the
things you can do in
Elementor:

Click on the 6 dots in
your banner section
and change out the
background image in
the Style tab to a
different banner
image.

Right-click on the 6
dots of the email optin
form and select
Delete to remove it.

Click the blue + sign in
any section to add a
new section above a
section.

Right click on any

rrrrrrr
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section and click
duplicate it.

Click and drag the 6
dots to drag the
section anywhere on
the page.

Click and drag any
column to move it, or
right click on the grey
column icon in any
section to add or
delete columns.

Click and drag the
pencil on any element
fo move it, or you can
edit the text, duplicate
and drag elements,
etc.

Click the Update
button to save +
publish your changes!

When you're done,
click the Hamburger >
Exit to Dashboard > W
(to exit to pages).

4.9 - Blog + Sidebar Design

You'll design the page that lists all your blog posts and set up your sidebar, make sure
it all looks great on mobile and learn some new WordPress tricks while you're doing it!
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We're going to create
template to display
our blog posts on our
Blog page.

Go to Templates >
Theme Builder > Add
New

Select Archive from
the dropdown, give it
a name “Blog Page”
and click Create
Template

B rewreveian

Templates Help You
Work Efficiently

Click the X to close
the Elementor
templates.
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Click the red +

©o
- L S— 000
Select the 2 columns
with wide-right and
narrow left (main
section with sidebar).
& .l
T
- - o 000
It'll look like this when [EEEETE]
you add the section. S
0o
T — 000
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Click on the 9 blocks

Ond find ArChive iE & Gosgie B UM DU ] Celender BB 2090 BDWC Bad '_"I;E? ,:'-“lr " h
Posts. Click and drag
it to the wider section. §
¢ 00
== [
-_I — Copyright 2030 | Shannan Mattern | A7 Rights Gesend CP Q c)
In the Content Tab, e e

the default will be 3
columns with the
image at the top. You
may not have any
blog posts yet so you
probably won't see
this much stuff and
you might not see any
images. That's okay -
we're just styling this
for now.
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Here are your display
options:

Change the setting to
one column - with an
Image Ratio of .66
your image size would
be 600w x 400h - this is
setting the size of your
featured image which
I'll show you how to
add to your blog
posts later.

S5+DAY WEBSITE CHALLENGE

Or you can change
the image ratio to 1
for a square image

1= SGUARE ||
|
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You can also align
your featured image
left and change your
image width to
40%-50%.

S5+DAY WEBSITE CHALLENGE

Blog

Image ratio of .6 is
500w x 300h (not
600x400 like the
screenshot).
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In the meta data
section, you can add
and remove things
like date, time,

-
comments, etc. | gl {
typically remove iy 40 ‘_ i
comments - click the
X to remove or click in
the box to get more
opftions.

You can change the
excerpt length to get
more words to show - ﬂ |
up in the preview. = _—
X'.‘ };:;j N\ /
Wy < .
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In the Style Tab, in the
Content section, you
can change the font
colors and font sizes -
just specifically for this
element on this page.

You can change the
title, excerpts, etc.

Change all the
options to style your
list of blog posts to get
them to look the way
you want.

nnnnnn

........ lt"_. };:, ;1 \ /
» Wy 4 ‘m -
- o3
. 5 : __J.;j \ |7
Jﬁ'.-v--’}; LB
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Now we're gonna
style our sidebar.

We'lladd an image,
a title, a description,
social icons and an
email optin form, and
then you can add
whatever other
elements you want to
have in your sidebar.

First, let's add some
space between the
main section and the
sidebar.

Click on the column
icon.

Blog
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Click the chainicon
so that you can put
independent numbers
in the margin - and
put 80 in the Left
margin.

To see what the
spacing looks like,
click the grey tab to
hide the Elementor
Panel.

Click the grey tab to
expand the Elementor
panel.

Click the pencil icon
on the image
element, click the
content tab and then
click on choose
image.

45}4—_._ -

= ng' i z?l'\'!
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Upload a square

image to use as your P
headshot and click e’ S
insert media. . F==— == !F’
] 1 : =E =2 §
| — ot
s R e ‘""
= ol = A1 ey . 8 00— &

If you want to make it | B
a circle, find the Z _

Border Radius, click - - 0 |

on the Percent % sign =\ = :
and put 100 in each e Bl \g ' gLy
box. - | ' a
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Click on the 9 blocks,
find the Heading and
click and drag below
your image.

BB 303000 Sy ik k== e | amaciar | Dlag Page % 44 g g ke D %

On the content tab,
you can change the
text and center it.
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Find the text editor
and click and drag it
below the heading.

In the Content tab,
add a description of
yourself, the click on
the Style tab and
center the text and
do any other styling
you want.

Abou
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Click on the 9 blocks,
search for the
shortcode and click
and drag it below
your infroduction.

Put <div
align="center">[conv
ertkit
shortcode]</div> in
the shortcode field
and click apply.

[ 2030000 Chatengm warkts i Tz o e x +
L i< St T gl @® s e w1
) Cairwan Shorimits B Garethll [ 014G B MMGE f Gosgebre @ SWCDU [ Ceente B9 3030508 Mad. [ RO Shoup Links B T e——
Heme About Biog

Hi, I'm Shannon!

Lorem (psunm dotor sit amet.
= consectetur adiplscing elit. Ut
T elit tellus. luctus nec
“ullameorper mattis, pulvinar

The Ultimate Guide for How To Move from R 55
Squarespace to WordPress

S0 y0u want to keow b 1o move frem SouareSpace to WordPness? You e in the fdght place!
Here's what this blog post cowers: The exact steps to take to mow from Squarespace to
WorelPress. How bo et up your web hosting? for just 5295/maonth. Settrg up WaerdPress

g s ot ', i

Click on the 9 blocks,
click on the Global
tab, find the Global
Social lcons widget
that you created
when you made your
footer, and click and
drag it between your
shortcode and your
description.

* HATO0 s Ga I

4. [ e Lk I tharokrm

Home About  Biog

Hi, I'm Shannon!

Lefem psum dobor sit amet

consectetur adiplscing elit. Uit
o SN elit tellus. luctus nec
e gllmpgTTe

5 pulvinar

The Ultimate Guide for How To Move from
Squarespace to WordPress

00U Want to keow how 10 move from SguareSpace (o WordPress? You'ie in the ight place!
Here's what this blog post cowers: The exact sbeps to take to move from Squarespace to

WardPress How bo set up wour web hosting® for just 52 95/month. Sett reg wp WerdPress

g ek T T
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You can tellit’'s a [

Global Widgef f‘ } 4,3,1 \ |7
because it's yellow Vs }v/’- 2
and if you edit it, it will R

change every place

you're using this

global element.

You can duplicate []75 _
elements to save . iy \ !,
time. Right-click on ﬁ‘- FER ‘
the heading below L

your picture,

duplicate it.
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Click and drag the
duplicated heading
to where you want it
on your page.

i!: —

_—

. © © | The Ultimate Guide for How To Move from
Squarespace to WordPress

The comct steps to take to move from Squanespace to

‘WordPress Haw to set up your web hasting? for just $2.95/month. Setting up WordPress
{includiing settings, plugins & thema))

sz [ Gkl [ OUAH [ MME & Cosghve 8 GOACEU [ Cente 09 I000ADMCIGd. B F hedn Lisks

Sa you want to know how 10 maove from SauareSpace to WardBrass? You're in the ight placel

T gl ® s Goa BT

* B SiherBockmencd

Hi, I'm Shannon!

Lerem ipsum dolor sit amat,
consectatur adipiscing efit. Ut
elit tellus luctus nec

ullamcorper mattis,
dapibus beo.

600

And then change the
text.

Add anything else
you want to add to
your sidebar.

= = The Ultimate Guide for How To Move from
Squarespace to WordPress

Here's what this blog past cowers
WordPrass Hew o set up your web hosting® for just $285/manth. Setiing up WardPress
{including settings, plugins & thema)

So you want to know how to move from SauareSpace to WardBness? You're in the aght place!

Hi, I'm Shannon!

Lorem ipsum dolor sit amat,
consectetur adipiscing elit. Lt
elit tellus luctus nec
ullarrcarper mattis, pulvina
dapibus leo.

Let's Connect

000

Next we're gonna
save all of our sidebar
widgets on Global so
that when we
recreate this page on
our individual blog
posts, if we make one
change it happens in
both places.

Home  About Blog

FETHI T [—
Lorem ip "
consecta!
alit tenus. IUCTUS nec
ullamcorper mattis, pulvirar
dapibus lsa
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Right click on the
sidebar element and
select Save as Global

Name it something
where you'll know
what it is and where it
is and click Save.

B uverary

Save your widget as a global widget

When you're done
saving all your
sidebar elements are
Global, click the
Green Publish Button,
then

Click add condition

n PLEILISH SETTINGS

Where Do You Want to Display Your Template?

D CONDITioN
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Select all archives +
save and close.

sssssssssssss

Where Do You Want to Display Your Template?

Go to your Blog page,
and now it will look
like this template that
you created!

If it doesn't, go to
Settings > Reading in
your WordPress
dashboard and make
sure your Posts page is
set to blog.

----- ] Join the Free 5 Day

4.9.1 - Blog Post Design

You'll design your blog post template so that your blog posts look gorgeous on the

front end (and are really easy to add on the backend).

We'll save the Blog page we just made as a template, apply it to our Blog Post
template and edit it to make it a single blog post.
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On the blog page you
just created, click the
little arrow beside the
publish/update
button.

Home  About Blog

Hi I'm Shannon!

Leram ipsum dolor sit amat,
consectetur adipiscing elit, Ut
elit tellus, luctus nec

ullarmearper msttis, pulvinss

Let'
The Ultimate Guide for How To Move from
Squarespace to WordPress
¥auU want 1o Know how ta maws frem SquareSpace to WardPrass? Yau'r in tha right placel S
ﬂm: what 173 blag post covers: The exact i
Click Save as
Homa Abaout Blog

Template

\ o

The Ultimate Guide for How To Move from
Squarespace to WordPress

560U want ta Knew how te rove from SquareSpace to WardBPress? Yau're In tha right placel
Bl Here's what thes blag post covers: The exact

Hi I'm Shannon!

Lorarm ipsum dolor sit amat,
consectetur adiplscing elit. Ut
elit tellus, luctus nec
ullarnoarper mattis, pulvinar
depitus lee.

Let's Connect
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Name it “Blog Page
with Sidebar” and
click Save

Click the X to close
out of the list of
templates
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Click the hamburger
and click exit to
dashboard

'VO' = d ’ LS l.}iv

g1
Jf',u-f%; | .

{

Hi I'm Shannon!

Click Templates >
Theme Builder > Add
New

Theme Builder | i

Fatanss futhor

Snerizods

seimmanior tamplate s *11376
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Choose Single > Post >
Blog Post and click
Create Template

Templates Help You
Work Efficiently

Choose Template Type

Click the X to close
out the Elementor
templates
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Find the Blog Page
with Sidebar and click
Insert

Click Yes on Import
Document Settings
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Now we're gonna
remove the list of blog
posts from our page
layout and add the

individual blog pieces.

Right-click on pencil
on the Archive Posts
element and click
Delete

Click on the 9 block,
find Featured Image
and click and drag it
to the wide column.

{‘fl/. EI“'V gl\’d‘f‘w !
1 teach peaple iika o how
o DAY thelr websies market

thamsahves onling and make
rfars |l in Sl
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Click and drag Post Tl ENPRSSEERERR

& O & anannonm il eom we- saminpas. phpfeeal- TEESA Y pnmtlumentony ® Gpsr® s Galaw§ o

title below the image NS eremorsms- BT s ————————————r T
Vv ," g Im

|7 o

| ¥ a Itmach peapis lika you how
= 3 10 DY thslr wabisites market
% thermaehves orfine and make

A — | —

— affars | e in Colunnibus,
Chig with my husband Floyd
and my dog Scarlett You
WanT find mea witheut my

— i marning coffee and my
b=l o laptap
000
c =
r— [T Join the Free 5

~ Day Website

A = Challenge!

o LI

Click and drag post S — - - | _
Cohfenf beloW _I_he ﬂle & O & anannonmstramely.comiw- Samn pos. ahp Tl TISEASE e sumEnTTe o GATO s Galawd o

o B Green . B eresH B9 west & Gorgubree & SWClE I Cabrdn B 2000 sowoed. B FR G Uk © B G Bk

W't find me withsut my
morning colfee and rry
laptop

000
Join the Free 5
Day Website

Challenge!

—2"  The Ultimate Guide for How To Move
o from Squ-~" -~ "ce to WordPress

----- -

L =g
N— [rar—
e Dvap it v
== v
g Privacy Pollcy  Tar Copyright 2020 | Shannan Matzem | All Rights Reserved oeo

Copyright 2020 | WP+BFF LLC | All Rights Reserved

193



S5+DAY WEBSITE CHALLENGE

Click and drag Post
Info between Post Title
and Post Content
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- The Ultimate Guide for How To Move
B o fro ¢ arespace to WordPress
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_So you want to know how to move from
5 a8
-~ SqguareSpace to WordPress?
" . [
a You're In the right place’ Here's what this blog post covers:
= The axact Staps to take to mave fram Squarespace to Ward Press
= Hew 1o set up your web hosting” For just $2 85/manth
= Setting up WordPress (including settings, plugins & theme|
= Migrating your existing content from your Squarespace site to WordPress.
inchuding pages. blog posts and images so that you don't lose any content!
= How o point your damain nama fram your old Squarespaco S1o o your now

\WardPrecs gite.
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Join the Free 5
Day Website
Challenge!

Delefte the Author,
Time and Comments
(leave just the Date)
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Meta Dana
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"~} The Ultimate Guide for How To Move
from Squarespace to WordPress

Shannon @ May 18,2020 ©30%am & One Comment

So you want to know how to move from
SquareSpace to WordPress?

Year're In the right place! Here's what this blog post covers:

Heed el

= Tha axact steps to take to move from Squarespace to Word Press.

= Hew o 4ot Up your web hosting® Far just $2 95/manth

= Satting up WerdPress including ssitings, plugins & theme|

= Migrating yeur existing content fram your SquareSpacse sits to WardPress,
Including pages, blog posts ard Images so that you don't lose any content!

= How to point your domaln name from your old Squarespace site 1o your new
WordPress sits.

AT fimd e withEut fry
marning coffes and my
lapton

000

Join the Free 5
Day Website
Challenge!
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etV M1 PR Withaut ey
marning coffes and my

Drag the post
comments below the

Post Content

Click the grey tab to
close the elementor
tab and see the page
full width
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—— JOIN TNE Free o
Day Website
Challenge!

The Ultimate Guide for How To Move
from Squarespace to WordPress

] . 2020

So you want to know how to move from
SquareSpace to WordPress?

You're in the right placel Hera's what this blog post covers:

= The sxact steps to take to

ve fram Stuarespace 5o WardPress

= o b set i your we * for just $2.95/menth,

= Setring up WordFress [including settings, plugins & theme)
= Migrating your existing content from your SquarsSpace site to Wird Press,
inchading pages blog posts and images 5o that you don't lose any content!
r o

A A frarm YouT okl SquArESEETE St T YoUr new

« How to redirect your old SquareSpace links t your few WordPress site,

Ready to move your SgquareSpace site to
WordPress?

Great® Let's get started!

When you have
added and styled all
your elements AND
adjusted for
mobile-response
(mobile + tablet) then
click Publish, and
select Posts > All and
Save and Close.

Now when you go to
any blog post, it will
display just like you
laid it out on this
template.

B roousk sermves

Where Do You Want to Display Your Template?

4.9.2 - Blog Post Creation
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Learn how to create a blog post and see how they display on your site. You'lladd a
title, text, featured image, categories + tags, and then look at your blog post and
page templates to see how it all comes together.

Your pages are created with the Elementor page builder, but your blog posts are
created with WordPress's built-in editor, so we'll cover that in this fraining too.

You'll also learn the difference between the WordPress Classic Editor (my fave) and
the Block Editor (aka Gutenberg) so you can choose the one that makes your life
easier!

Blogging 101

Your blog is where you publish content on a consistent basis to attract, educate and
engage your audience.

You write blog posts on specific topics related to your niche that your audience is
interested in learning about, and then you publish them on your website, send them to
your email list and post them on social media.

| go intfo a more specific strategy inside the Website Marketing Lab on how to use your
blog content to attract your ideal client and nurture them and turn them info a
customer. In this training I'm teaching you how to publish your blog posts.
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Anatomy of a Blog Post

# Elernentor Tutorial B + Hew Caching

B Edit with Elsmentar Gave Draf Preh ‘ Puklish,. }

Document Black

§® Dashboard g - ®
* Posts #l = Itle Status & Visibility -~
April Income Reporﬂ
#2 - Content #6 -Publishing Options  Pubish

Weleome ro my April Income Report! Every manth [ publish an income [0 stick ta the top of the blog

repart to take you behind the scenes of my online business and reveal

exactly how much money I make, how much I spend and lessons learned O pencing Reviaw

along the way! . 1 )

donetien #4 - Categories categories ~

er Listen to this income report on the podcast! #5 -Tags ™us ~

o s #3 - Featured Image resureaimsos %

— i e X "
s Tem View all of my income reports here!

Set featured image

Important Things That Happened in

s Excerpt ~
April:

Discussion w

« We kicked ofT the Website Marketing Lab with a new round of Post Attributes o7

students going through the 8-week program.

1 Instagram Feed

Later in this episode I'm gonna break down my entire launch strategy

for you and give you all the stats and numbers o yon can see what

o oo Wl

Blog Post Checklist - get printable checklist.

Featured Image + Alf Text
Keyword/Phrase

Title

Content

Categories

Tags

Publishing Options

0 O O O O O O

Creating Featured Images

Use Canva to design your featured images. Include an image that aligns with your
brand, overlay text.
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To learn how to design gorgeous, eye catching images | recommend Applecart
Lane’s “Pins Made Pretty*” course - even though it teaches design for Pinterest, the
design tricks you'll learn are applicable to any graphics you need to makel!

Your featured image can also just be a Pinterest graphic!!!

Pro tip - after you download these images from Canva, upload them to TinyPNG.com
to compress them, download the compressed images, upload those to WordPress and
let WPSmush smush them even more so your site loads faster!!!

Featured Image Suggested Dimensions

e If you chose image Ratio .6 in Module 4.9 when you designed your Blog Page:
use a landscape featured image that’s 600 width x 400

e If you chose image Ratio .66 in Module 4.9 when you designed your Blog Page:
use a landscape featured image that's 500 width x 300 height
Square: 1000x1000
Pin (portrait): 735x1102

Stock Photography Resources for Featured Image backgrounds an in-blog post
images:

HauteStock*
Canva Pro has built in stock photos

Unsplash
Styvled Stock Society

Adding a New Blog Post
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From the WordPress
Dashboard, Go fo
Posts > Add New

OR from the +New
option in the Admin
Bar, select Post

You have the choice of using the WordPress Block Editor (left) or installing the Classic
Editor (right). | use and recommend the Classic Editor.

If you want to use the Classic Editor, just go to Plugins > Add New and search for
Classic Editor (it's usually right there on the main new plugins page) and click Install
and Activate - and that’s it!
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Creating a Blog Post in the Block Editor vs. Classic Editor

Block Editor Classic Editor
: - ===

A S )
Add title Ep 287 1 810 Oiew fou S Hustlwith Ang Truallose | s

hsssaca_tich, g " A s Pkl AT g Prmbicid FTSAL gV

s heing o podeast guest part of yosr marketing strategy yet! ¢
W, i s g o =

Viewing/Changing the Blog Post Link (permalink)

Copyright 2020 | WP+BFF LLC | All Rights Reserved

201



S5+DAY WEBSITE CHALLENGE

o a= [ Jo
Ep. 287: Using Podcasts to & -
Grow Your Side Hustle with - —

Angie Trueblood

[rmy— &

o o nt

Adding + Formatting Text
“Chunk” your text: 3-5 lines max, decent spacing
Narrow columns, lots of white space
Dark colors, readable
Use h2 to break up sections

HOME ABOUT CONFERENCE=- RECISTER BLOG CONTACT

2) Putting the keywords in the right place h Content headings,(H2)

As | mentioned earlier, search engines can't see what your page looks like, it can just see the

h sufficient line,;spacing

content on the page. So for Google to know with confidence what your blog postis about, it's

important to place your keywords where Google expects to see them,

Thisis why | love self-hosted WordPress as a blogging platform over other platforms. There’s a

plugin called Yoast SEQ that's the industry standard SEO tool to help you make sure that you're

putting your keywords in the right place. You tell Yoast what your keyword is, and Yoast will tell chunked content {6 lines _orJless]

you all the places to put it in your content plus all the other things to do to optimize the blog
post, and it will give you a green light when you've completed them all (or you can choose to not

complete them all if it doesn't feel organic to your topic).

If you're using WordPress, install Yoast and start using it right away! If you're not, here, but make
it a practice to link to a few of your other blog posts in each post where it's natural and it makes

sense.

narrow,columns, (=1024px)

4) Link to other websites

I R P o L o T ey ey e ) PP ey gy

=

e Personal, not corporate
e Be yourself, speak to one person.
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Type the content and then click the Type the content, highlight it and select
“transform™ icon Heading 2 from the dropdown.
B - - == =
Ep. 287: Using Podcasts to
Grow Your Side Hustle with o— -
Angie Trueblood
Click “Heading" e
W == — 1- L

Ep. 287: Using Podcasts to
Grow Your Side Hustle with =
Angie Trueblood

Type and format content in one open
space.

Select H2 (or whatever content heading
you're using - typically it's H2)

H:-- - o= —T-F

Ep. 287: Using Podcasts to
Grow Your Side Hustle with
Angie Trueblopa

Is being a podcast guest part of your
marketing strategy yet?

Hit the enter key or + sign to add a new
block/paragraph and format
accordingly. It will always default to
paragraph text.

Text formatting options
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In the Block editor you have to type the
text first and then click info that specific
block to get your formatting options:

B:- - o= [~ T-F

Ep. 287: Using Podcasts to
Grow Your Side Hustle with
Angie Trueblood

k) Is being a podcast guest part of your
& PR B L2 il

-

When you have your cursor in a block,
you can click the little down arrow to
get more formatting options like adding
an image in the text, text color, etc.

B-- == =0

Angie and I talk about:

Click the + to get a list of all the
available types of blocks you can add
to your post, including Images (don't put
your featured image IN your blog post,
we'll add that somewhere else)

In the Classic editor all of your formatting
opftions are at the top of the screen and
you just highlight your text and click one
of them to apply it.

s rciil=s 0 .
O] o L3
e s ©

Hit the toolbar toggle icon to see a 2nd
row of options:

<o an e

Angle s 11alk abuoun:

All of the options for your blog post are
always on the right-hand side of the
screen:
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@ IE o= e e
) s
v .
A

[=

;
L] e e

e} -

Scroll down in the list of block to see
more blocks. Sometimes plugins add
blocks too - like you'll see Yoast SEO
blocks in the list:

......

My favorite quotes from Angie: —

« Wsdintha

pne glan wiageal basiess 1 e fonm

When you click on any block that
you've created, you get different
options in the right-hand side of your
screen - and you'll see that it’s showing
Block options because the word Block is
underlined.

Options for a Heading block

W - =
o
- =
n @+

S m-omogo# - e -
My favorite quotes from Angie:
L] oe
B em et st af bustans b2 be Seurrd m .
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Options for a text block:

B - o= =0
I not. wiirts Bakding you Sack? =

<<<<<<<<<

Angie and I talk about:

f you want to see Document options (all
the options for the whole blog post and
not just the blocks, click on Document).

Making Links

Highlight with your cursor the text you want to turn into a link. Click the chain icon.

If you're linking to:

e An external website: Type the full link, starting with http, and always choose

“Open in a new window"”

e A page or post on your own site: you can either search for the page or post
and wordpress will give you a list that you can click on to link to, or you can
type in the full link or just the end of the link after your domain name, so just
/blog if your URL is https://yourwebsite.com/blog. Don't choose open in a new

window if you're linking to pages on your own website.

Highlight the text and click the chain
icon

Highlight the text and click the chain icon
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Type in the URL or search for an existing
page or post on your site:

Choose whether you want it fo open in
a new tab or not and press enter to add
the link.

,.

[] efnm r
v
@

Angie and I talk about:

Type in the URL or search for an existing
page or post on your site:

—-A:MoBnEDS @

Angie and talkabe .

Click the gearicon to get more options,
like opening up the link in a new tab +
press Update to save your link:

Uploading + Linking to a File (PDF)
If you want someone to be able to click a link on a page or post and download a

file, this is how you do it:
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Click the +, select Common Blocks +
Choose File.

- - o= =0

My favorite quotes from Angie:

Click Upload. Navigate to the file on
your computer and click Open to
upload it.

B::- - o= = 1-TH

My favorite quotes from Angie:

busia s b byt

The file name will appear beside a
Download button

My favorite quotes from Angie:

[ O] OifF ¢
14

You can change the file name and/or
change the text on the download
button OR toggle off the download
button

Type the text you want to turn into a link
and highlight it - then click Add Media

Click Upload Files. Navigate to the file on
your computer and click Open to upload
it. Then click Insert Into Post. Change the
Title to make it say whatever you want
the link to say:

If you forget to change the fitle when you
upload it like | do all the time, you can
click on the link icon
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When people click on the link in your
blog post (or on your page) the file will
download.

I heing n podeast guest part of your marketing strategy yet?

15 being a podenst guest part of your marketing strategy vet? i [ |

e

Change the ftitle and click Update

And the text will change - when people
click on your link, the file will download.
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Adding a Featured Image

This is the image that will display at the top of your blog post, on your blog page, and
any other place on your site where you're showing blog posts.

Click Document > Featured Image > Set | Click Set Featured Image, upload your
Featured Image, upload your image image and click Save.
and click Save.

0 o o= =a

Yeu raad g prar buasma i 3 of permsiist At

Angie and [ talk about:

[T ——

iy,

My favorite quotes from Angie: T

Adding Categories

Categories are the core topics that you write about on your blog. You should create
categories that you expect to write multiple blog posts for that category. Every post
should have a category selected (don’t leave them as Uncategorized).

Click Document > Categories > and Scroll to Categories and check the
check the category you want to use, or | categories you want to use or click Add
click Add New Category to create a New Category to create a new one.
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new one.
w 5 =n
Angie and I talk about: sl .
My favorite quotes from Angie: g L‘ ° “ o -
w 5 =n
Adding Tags

Tags are the topics that are in a specific blog post. So if | have a blog post about
moving from Squarespace to WordPress, my category would be Tutorials and my
tags would be “squarespace, self-hosted wordpress, website migration, redirect links,
change domain name” | wouldn't make “Squarespace” a category because | don't

typically write articles about SquareSpace.

On the Document Tab, click on Tags,
type in your tags and hit enter between
each word.

Scroll to Tags, type in your tags and hit
enter between each word.
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My favorite quotes from Angie:

b i o ki 1 Lo e

=

Publishing Blog Posts

You can publish blog posts immediately or schedule them for the future. They will
appear on your Blog page when you publish them.

Click the publish link to set a publish
date IF you want to schedule it for the
future, otherwise just click the
Publishbutton:

Ep. 287: Using Podcasts to
Grow Your Side Hustle with
Angie Truehlood

Confirm your settings and click publish
again (or you can uncheck the box in
the bottom right corner to disable this
confirmation screen in the future).

Ep. 287: Using Podcasts to
Grow Your Side Hustle with
Angie Trueblood

Is being a podcast guest part of your
marketing strategy yet?

I gorea rakr e g that

Click Preview to see what your post looks
like (optional). Click Publish, or if you want
to schedule it for future publishing
automatically, click Schedule and select
the date and time and then click publish:

Confirm the post was published:

Ediit Pagt [ 11 e

..... Ep. 2B7. Using Podcasts to Grow Your Side Hustle with Angie Trusbiood Pubish
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The confirmation will show up in the
top-right corner of the screen.

Ep. 287: Using Podcasts to
Grow Your Side Hustle with
Angie Trueblood
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Day 5 - Email List + Go Live

5.0 - The Big Picture

I'll break down what you're gonna do in Day 5 so that you know exactly what to have
done before you go live.

If you hadn’t considered starting an email list, | wanna share with you the 5-Step
Formula for marketing your online business. Being able to communicate with your
potential customers via email is a critical piece of this formula. Email is an
algorithm-proof way of initiating communication with people who have said “YES, |
want to hear from you!”

Your email communications are used to build frust, and once you've earned the trust
of your subscribers, it's time to make offers for your products + services and invite your
subscribers to take the next step with you.

5 Step Formula for Marketing Your Online Business

Build a Website

Create a Freebie

Share Freebie online to Drive Traffic to your Website & Get Email Subscribers
Build a relationship via email

Make offers

a0 N -

Click here to sign up for my free webinar all about how to market yourself and get
traffic (even if you have zero ad budget and no social media following >>

You'll learn:

e The "secret" 5 step formula for getting website visitors and turning them into
customers.

e 5 marketing myths keeping you busy, stuck and broke.

e The only 4 things you need to set up to market yourself online.

e 5 common marketing mistakes (and what to do instead).
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e How you can get started authentically marketing yourself right away!

The Workflow

Here's what we're gonna set up in 5.1, 5.2 + 5.3:

e Visitor lands on your website, sees an irresistible call to action to get a freebie
that will help them solve a problem and enters their name and email address in
the optin form you embedded on the page.

e After submitting the form, the name and email address are sent to ConvertKit
and your visitor is redirected to Thank You page that thanks them for signing up
for your freebie, and instructs them that an email is on its way, to check their
email, look in the spam folder and contact you if they don’'t see it in their inbox
in 10 minutes.

e ConvertKit automatically sends an Incentive Email to your subscriber with your
freebie. If you don't have any clue what to make for a freebie, sign up for the
free webinar here!

e Subscriber checks email, gets freebie, takes action, gets results, falls in love with
you.

e You send out a newsletter (ConveriKit calls the Broadcasts) manually on a
consistent basis to build trust, make offers & learn more about your subscriber.

5.1 - Email List Setup with ConveriKit
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Create your account
here* - you get a free
plan up to 1000

subscribers when you

use my affiliate link. N |

Convertkit saves me 5o much time and meney every month - tg

" say Imin love is an understatement
§
sh atLer m

SHANNON MATTERN g
I Priy Business Ive had the oppertunity 1o dig Into just bour every email marketing

Click the option that
best describes you

Do you currently use an email

ing teol in your i 7

Vst Fm mioving from annthar toal, |_Na v just starting with email.

Click Yes

Nice! ConvertKit is great for beginners. Do you have a website?

We use this 1o healp you set up forms and landing pages,

o
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Click WordPress

Nice! ConvertKit is great for beginners. Do you have a website?

We use this to help you sat up forms and landing pages.

SOLIARESPACE

[ ';‘:\i;:l‘\'cln!l’:;f%: . ‘] Mfy

Enter your BUSINESS
email address that
you created in
Module 1.8 here - not
your personal email
address, set a
password and click
Get Started.

Be sure to go check
your BUSINESS email
account for a

confirmation email.

Last step: Log in details
Let's secure your account and get started!

Envter you BUSINESS email address!s

iy joining, y0u agree 10 the terms of sendoe and prisecy pofcy

ani Terms of Sarvce apply
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On the account info
tab the only change
to make is under
Subscriber Consent
Options. Select Show
Only to Subscribers
currently in the EU.

rrrrrrr

Account Info
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On the Email Tab,
update your address.
If you don’t want to
use your own address,
you can use
ConvertKit's:

113 Cherry St
#92768, Seattle, WA,
98104-2205

Learn more here
about the
requirements of
using their address:
https://help.convertk
it.com/en/articles/25
02494-alternatives-fo
r-your-physical-addr
ess

Email Settings

Address

No changes on the
Custom Domains,
Team:s, Billing or
Referrals tabs.

5.2 - ConveriKit Form Setup + Incentive Email Delivery

The first thing we'll do is set up the Form you'll put on the homepage of your website so
that when people subscribe, they get an email from you with their freebie.
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Click on Forms +
Landing Pages (not
Automations) at the
top of the ConveriKit
Screen, and then
choose “Form”

Welcormne + Freebie Delivery A

| | :
How do you want to gather subseribers?

Select “Inline”

Welcome + Fraebie Dellvary A =

==
Choose the display format of this form

=

e infine " Micda Slide in

Click the template
that looks like this:

Welcoma + Freehie Delvery A >,

Click the gearicon.

Welcoma « Freebia Debvery & Clare form

et &rst An Vo aivsil ddrase
=
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Click redirect to
another page

Welcome + Freebie Delivery & Clare form = FREVIEW

=g Settings

Vour firat rerma Your il addidrens

REFORTS m

Click the email icon
and make sure the
“Send incentive
email” option is
checked. Then click
“Edit Email Contents”

Click and drag the
bottom right corners
of each section of the
incentive email to
expand the typing
areq:

Incentive email

This email will be sent to new suhscribers to this form

From email address
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Click on the “From
email address”
dropdown and
choose your email
address:

Incentive email

This emall will be sent to new subscribers 1o this form

From email agdress

on@wp-bif.com>
Impastant: confinm your subscripticn

Messape

Thanks fer signing up, Click the link below te confiem your subscription and you'll be on your way.

Confimm your subscription

It's goad to have you!

Change out your
subject line to
something that tells
them what's in your
email, and write your
welcome email,
letting them know
what results that they
can expect from your
freebie, who you are,
why you do what you
do and what to

expect going forward.

Incentive email

This email will be sent ta new subscribers wo tis form,

Fram emall address

Shannon Mattern <shannen@shannonmatern.coms w

Subject

Frea 5 Diay Website Challenge Insidel

Message

Hey there! Thanks for signing upl

Results you'll get from taking acticn on my freebie:

Confirm your subscription

Intreduce yourself, share a litle more about what you do what you do, and let them know what to expect from you going forward.

See you soon!

Shannon
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Next we'll update the
button by clicking and
highlighting the button
text, and then
changing it to
something more
exciting like “Click
here to download
FREEBIE”

Then click the X at the
top right of the screen
to save your changes
and go back to the
last screen.

Incentive email

This email will be sent to naw subscribers ta this ferm,

(x)

Next, check the
“"Autoconfirm New
Subscribers” box.

Incentive Email

Send incentive email

This will be sent ance to new subscribers
from this form.

Edit Emall Contents

Auto-confirm new subscribers

After confirming redirect to:

[ Download
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Finally, you need to
tell ConveriKit what
you want to have
happen when
someone click that
button in your
welcome email:

If your freebie is a PDF
or other
downloadable file,
click Download.

If your freebie lives on
a website, like it's a
video on a webpage
on your site, then
choose URL and follow
the steps to either
upload your file or
paste a link to the
page you want
people to go to when
they click your button.

Incentive Email

Send incentive email

Edit Emall Contents

Autoe-confirm new subscribers

Incentive Email

Send incentive email
This will be sent once to new subscribers
E froem this Form.

Edit Emall Contents

Auto-confirm new subscribers

After confirming redirect

Choose a file

Next, we'll style our
form.

Click the subscribe
button and change
the color code to your
brand color.

Welcome « Freebie Delivery 4 Clare form

Varut firat resihg Yeur sl adirean
=2

Copyright 2020 | WP+BFF LLC | All Rights Reserved

224



S5+DAY WEBSITE CHALLENGE

Highlight the word
“Subscribe” and
change the text to
something more
enficing!

=

Welcome » Freeble Delivery A Clare form

Your first rama

T FREVIEW £ REPORTS
Buttan Seyles
S Font Tokr Backeround tolor
r e Bander radiu
1 N

Welcoma + Freeble Delivery & Clare form

Wour amai ackdress

= FREVIEW £l "
Burton Sayles
VER EEN ME L= Foit oo Backgr oo taks
Barder radiis Fovd Weght
a i N

Highlight the form
name and change it
to something more
meaningful to you.

Click Save.

aur drst name

Welcame + Freebie Delivery & | Homepage Opein Form

ot Kret g

Year amai ardrgs

¥ ESF SKEN ME LRI

5.3 - Add ConveriKit Optin Form to your Website

Next we'll install the ConveriKit plugin and connect ConveriKit to your website!
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In your WordPress
dashboard, go to
Plugins > Add New
and search for the
ConveriKit plugin and
click Install and
Activate.

By ConvertKit

(2)
20,000+ Active Installations

ConvertKit

ConvertKit is an email marketing platform for
capturing leads from your WordPress blog.

More Details

Last Updated: 1 month ago

v Compatible with your version of WordPress

Then find the
ConveriKit icon in
your dashboard
menu, mouse over it
and click “Settings”

# Dashboard

# Shannon Mattern <1 B 1

Plugins Add New

Posts All (52) | Active (48) |

1 Media Biilk Actions

Forms
Pages
Comments 1

Pricing Tables

HappyForms

»¥ Appearance
K& Plugins 1

Installed Plugins

Tools

M E-'E‘W Apps

SEO

=# Pretty Links
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Click the “Get your
ConveriKit APl key”
link and it'll take you
to your ConvertKit
account page.

Click the “Get your
ConveriKit APl key”
link and it'll take you
to your ConvertKit
account page. Copy
your APl key, then go
back to your
WordPress site and
paste it in the APl key
field.

Eantem Domaing

Account Info

Then click “Show”
under APl Secret,
copy that key and
paste it in the API
secret field.

Your Profile

Account Info
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Under subscriber
consent options, click
“Show Only to
Subscribers Currently
in the EU”

Account Infa

............

Siiniriter Gemrt Optiony [GOFE conpiance)

Once you have your
APl key & secret
pasted in, click
Refresh Forms, then
save changes.

Convertiit

Genersl | Tools

General Settings
@ F =
L

bex I

AP Secret

Ddamit Ferms
1§ Sottnge

Debag

This wil izahile the cusiom content and tsgging Ikstures of the ogin. Does not apoly

Drmabls jmmscript
wkh couthon

tn anding peges . Lse

Go to Forms &
Landing Pages, click
on your form, and
then click Embed.
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Click Wordpress &
Copy your Shortcode.

Keep this shortcode
handy for the next
step.

Back in WordPress, Go
to Pages > All Pages,
find your Home page
and click on “Edit with
Elementor”

Scroll to the section
where you added a
Shortcode element
and we put some
placeholder text in
there for our
ConveriKit shortcode
+ replace just what's
inside the brackets
with the shortcode
you copied from
ConvertKit.

Click apply and save
the page.

lewen if you're not techie)

Stop struggling and finally get your website online!

..............

Prluaecy Ralicy  Tarms + Confitios Copryright 20201 Sharrian Mattam | AL Rights Resrand

=

(even if you're not techie)
I'll show you how!

o

Stop struggling to figure out WordPress and confidently launch your
website!

o e
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Repeat on your Blog
Page Template also -
and because you set
it as a global widget
in your sidebar, it will
show automatically
on your blog posts
too!

To do that go to
Templates > Theme
Builder and find the
Blog Page with
Sidebar Template that
you created and click
on Edit with
Elementor.

Click on the pencil
icon on the
Shortcode element.

Click the green Edit
button.

Replace the
shortcode with your
ConveriKit shortcode.

Click Apply + Save +
Close.

Check your Blog
Page and Post on the
front end and you

(even if you're not techie)
I'll show you how!

o

website!

o T e

Stop struggling to figure out WordPress and confidently launch your

i ;
- A ( =
2 B8

Your Widge! Is Mow Locked

The Ultimate Guide for How To Move from
Squarespace to WordPress

S0 YU WENT 10 Know Pow o mowe rom SquaseSpace 0o WordPress? Youre in e right
place! Here's what this blog post covars: The exact staps to take to move fram

Uares pace 1o WordPress How 1o st up your web hosting” for just $2 95/manth
tting up WordPress {including settings. plugins & theme)

~~Website Challenge!

- "
| teach paople fike you how ta DY
their websites, rmarket thermuelves
onisna and make offers. | e In

Calurmia, Ohio with my husband
Flayd and my dog Scadett ¥ou wan't
finel e without iy mesming cofles

and my laptop

Join the Free 5 Day

)

tipsdato chingee 10 page

= Shorieode

e ol

The Ultimate Guide for How To Move from
Squarespace to WordPress

S0 yau want 1o know haw to mowe from SquareSpace to WardPress? vou're in the rght
place! Hera's what this blog post covars: The exact s1eps to take ta mowve from
uarespace bo WiordPress How to set up your web hosting? for just 52 85/month

5o
gmng i WordPress {including settings. pluging & theme)

o e

| teach people lhe you b o 0
their websites, market themaslves
aniing and maks offers, | e In
Colurmibus, Ohio with my husband
Fiayd and my dog Scadatt. You wan't
finel me: without my moming coffes
and my lapton

Join the Free 5 Day
Website Challenge!

Your first name

Pt By EoneeTa
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should see your
ConvertKit optin form.

Test the form! Sign up, make sure it redirects you to your Thank You page, and that you
get your incentive email.

Note: You can only test once per email address! If you have a Gmail email address,
you can test multiple times by adding a +whatever after the first part of your email
address before the @ - for example: youremailttest1@gmail.com,
youremail+test2@gmail.com, and so on.

5.4 - GDPR + CCPA Setup

| recommend watching this video because it covers all the legal stuff that you’ll need
to have set up on your website, including the European Union’s General Data
Protection Regulations (GDPR), California’s Consumer Privacy Act and more.

By the end of today you'll feel super confident that your site is compliant with laws that
govern internet privacy, and you'll know where to go to get your legal questions
answered.

Resources

WonderlLegal Free Privacy Policy Template
Autumn Witt Boyd Templates*®

GDPR Blog Post

Suzanne Dibble’s GDPR Pack*

The Legal Roadmap Podcast
Pep Talks for Side Hustlers interview with Autumn Witt Boyd
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I'm not an attorney, none of this is to be consfrued as legal advice, and use any of the
resources linked here at your own risk. Please consult your own legal advisor to

determine what's required and appropriate for your business.

Set up the Cookie Notice Plugin

In your WordPress
dashboard go to
Settings > Cookie
Noftice

et it Sammary

iR your Site €3 Dashvoard

COMPLETE ACTIVATION @
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Here are all my
recommended
settings for Cookie
Notice: o e

Configuration

. 1
=]
Button text
=
Peivacy policy
[ ] "

e use eonsant

Ressnke censent

Seript biocking

! Cookie Notice

Cookle Notloe 1.3.2

Hued spport

it e o Eve b cw or pur webste. [n

Do o it plugnT

< Enable privozy poloy k.

Frivacy policy

Prruncy Palcy poge

< Erabie to give to the user the possibiny o refuse thind party non lunctiossl cookes.
e

o Emabie to give o ther user the possibity o rmn ke kel ponssnt (requies “efuse consent” ooton
Bnsien)

‘ou zan revcke your consen any Time using the Revoke conssnt bution
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And you can set the
location of the notice
plus button style +
colors to match your
branding.

Redcacing

O sl

Accapted expiry

Rejacted aspiry

Currert cases

Button s3yse

Enabia to reear 1he page attar the netice |s accapled

) veador [ Feoie

bl I yous want l egin cat o bw deiatad on descthvation

FS DEndumia and five SHEps recomaanded By the WHE (Werid

5.4.1 - Privacy Policy Creator

Watch as | walk through and answer all the WonderlLegal Privacy Policy Template
Generator questions so you know how to answer them for yourself when you create

your privacy policy.

5.4.2 - Terms + Conditions Creator
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Watch as | walk through and answer all the WonderLegal Terms + Conditions Template
Template Generator questions so you know how to answer them for yourself when you
create your terms + conditions.

5.5 - Yoast SEO Setup

We'll get your global SEO settings set up today, plus your page-specific SEO settings,
along with how to control how your pages show up on mobile search results,

Facebook and morel

Go fo SEO > General
and click on SEO
Configuration Wizard

Dashboard  Featurss  Webmaster Tools

Upgrade 1o Yoast 320 Premium

you're ready to go
live. Click Next.

If you're not ready to
go live, click Option B
and we'll come back
here when you're
done and change it
to Option A when
you're ready to go

w‘“ F'rsttlme SEO c.cl_r|ﬁ?ur.a?inr!
+ Problems (0)
¥ Natifications (0)
Choose Option A if ye
yOU hOVe O” yOUr Yoast SEQ for WordPress installation wizard
content done and © sreomest o o o o (] (-]

Blmuss wpmeify if your
Chooss under oo
nggiratss, Don'

I

(E} Cption A: My sita ia Tve and

Ciptinn 8; My site is onder conssuction and shoukd not be nceed
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live.

Choose what type of
site you have. If you
don’t know you can
choose Something
Else

v

Yoast SEO for WordPress Installation wizard

L] 0 ety e o L: ]

What dees tha site b el 17

Select yes on pages
and posts, no on
everything else

Y

Yoast SEG for WordPress installation wizard

] -] -] © search sngine viskiiey o

Please specify whal content types you would e Lo sppear in search
angnas, If you da nat know tha diferances batwean thess, i's bestto
choase the default settings.

ta* in =
Yoo
Ha
agos
Yea
Ho
¥ Tomplates” &
s
(OF ]
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Choose No on
multiple authors

v

‘Yoast SED for WordPress installation wizard

Leave Title Settings as
is (unless you want to
display a different
name in Google
Search Results than
what's showing)

(] (] o o © Mutiipls aithors [: ] []

Does, orwill, your site have multighe awthoes®

10U choase no, your suthor archives will b doactivated b prevent duplicate content

Issues,

fes Yy
= Ha
Mo
X CLOSE THE WIZATI
v
L
Yoast SEO for WordPress installation wizard

[ ] [ ] (5] ] 0 0 Tiie erttings 7]

u

separator to use. The separstor will display, for Instance, DEtwean your past
tithe and site name. Symibols are shawn in the size they'll appear in the search
FeguURE, Chooss tha one that Tits your brand best ar takes up the east space
inthe snippets.

‘Wahaits name

Sitw 11 8 Srap Tamplate Puck

Titte Sepuerator
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Click Next

Outrank the competition with Yeast SEO Premium

D0 you want 10 outrank your competition” Yoast SEO Prenium gives you swescme
adgitianal features that'll heip you 1o 561 up your SEO strategy like a professianal, Add
synonyms and related keyaords, use our Premium SED analysis, the redinect manager and
ur intermal irking bock. Yoast SEO Pramium will sisc glve you 2cess to premium support.

Find out what words your audlence uses to find you

Keyward research is exserrial in ary SEQ strategy. You decide the sesrch terms you want ta
b T For, and Figurs out what wards your sudisnce uses 1o find you. Great keywond
research tells you what content you need ta start ranking far the terms you want to rark for,
Maka sure your eitorts gointo the keywonda you sctually have 8 chance at ranking far! The
Kayward rosearch training waiks you through this process, step by step.

0 KEPWORD RESEARCH TRAINING

[ Hoste

Click Close

Yoast SEO for WordPress installation wizard

) Sucoesst

ioast SEQ will now take care of all the needed technical aptimizatian of yaur site. To.
really improve your site’s perfarmance in the search results, it's important 1o know
averything our plugin has to offer. Sign up for our free Yoast SE0 plugin training, n
wehich you'll iearn haw fo use Yoast SE0 and how it can help you make the best of your
webaitel

= Prayious Clozs

Go to Pages > Alll
Pages, find your
Home Page and click
Edit (not Edit with
Elementor)

B poges
AN Pages
"

B¢

Drafs {21 | Comeraion
Bule Actions || kapy | | ARdater || ANSEO Seares w || M mosdabiy Seeres || |
it e Oale a
Aoyt — Elemenisr Sharcan [
About — Elemmerior "
1
By = Posts gy T—
= it Bage, Flnmentor Shansan 4
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Find the Yoast SEO
section and click on
the SEO tab. This is
where you can enter
the keyphrase that
describes your blog
post and look at
Yoast's analysis + fix
any problems.

Write for your ideall
customer FIRST, then
search engines.

Edit Page [ s v |

Home Publish

Back
[ o wits Eemenicr
Page Attribute:
Paren
‘¥oast SEQ . Hameraor Ful Widih ~
et
® @ Ruadat e
8
Fecus kepphraie §
DY Wb De wir
Gaola proviow - Fuatured image
Praview ax
&1 tinhie sl () Gesitop et

b st mehanced 6

right 2020 | WP+BFF LLC | All Rights Reserved

239




S5+DAY WEBSITE CHALLENGE

Click on the
Readability tab to see
Yoast's suggestions
for improving your
formatting.

Write for your ideal
client first, then for
search engines.

Elit Page [ s nw |

Home

# Back to WordPress Edaor

hame

Shanren (shaneni2 Sklustostdemal

Orter
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Click on the Social R DTN
Tab - here you can | 0 @ ey <

control what shows : :
up when you post a e

link to your website
on Facebook. You
can set a title, a
description and even
a different image
than the featured e SRR
im a g e .I. o Sh oW on e A2 ettt e e e
Facebook.

Featured image

Do this on your
homepage for sure,
but you can also do it
on any page or post.

SEO Optimizing Blog Posts

You'll want to SEO Optimize every blog post you write before you publish it:
In your blog post, scroll down past the content section to the Yoast SEO section.

The first thing you'll notice is a place to add your “focus keyphrase” which the phrase
that someone would search for to find your blog post. In this case, my post is all about
how to move from SquareSpace to WordPress, so | made my keyphrase “SquareSpace
to WordPress”. | could have included the entire question “how to move from
squarespace to wordpress” in my keyphrase. Yoast will now “grade” my blog post
based on this key phrase and it's my goal to get a green light.

1. Enter a focus keyphrase.
2. Click on the snippet preview to open up the snippet editor.
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Yoast SEO a

@ SEO @ FReadability & Social £ Advanced

Focus keyphrase @

SquareSpace to Wordpress

Snippet Preview ~

() https:ewew. wp-bff.com » the-ultimate-guide-to-moving... .

Th e Guide to Moving from
ordpress 2019

This step-by-step tutorial shows you exactly how to mov
or website from SquareSpace to Wi
From moving you

0 L= & Editsnippet

@ SEQ analysis v
SquareSpace to Wordpress

+ Add related keyphrase v

Cornerstone content .

You can enter an SEO title that's different from your blog post title if you want, but |
recommend making them the same - just use your keyphrase in it.

Enter a meta description that includes your keyphrase - if it's too long or short it'll be
orange - the right length it’'ll be green.
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Snippet Preview

2 https:iwww.wp-bfi.com » the-ultimate-guide-to-moving. ..

The Ultimate Guide to Moving from SquareSpace to
Wordpress 2019

Get step-by-step instructions on how to move your blog or
website from SquareSpace to WordPress, including tips +
hacks to speed up the process!

0 - & Edit snippet

SEQ title @ Insert snippet variable

The Ultimate Guide to Moving from SquareSpace to Wordpress 2019

Slug

the-ultimate-guide-to-maving-from-squarespace-to-wordpress-2017
Meta description © Insert snippet variable

Get step-by-step instructions on how to move your blog or website from SquareSpace to WordPress,
including tips + hacks to speed up the process!

Close snippet editor

Scroll down to the SEO Analysis and click on it to open up the options. Here Yoast will

tell you what you need to do to get a green light on your post, which means it's well
optimized for Google, which means Google knows what the post is about and it's

formatted well for display in search engine results.

This does not mean your post will show up on the first page, or even the first 100 pages

of Google search resulis!!!!

There's a lot more to Search Engine Optimization than the Yoast settings (keyword

research, long tail keywords, backlinks, etc.) but having your blog post set up correctly

is the first step. Learn more with the 10 Simple SEO Steps Checklist.
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@ SEO analysis A

SguareSpace to Wordpress

4+ Add synonyms
+ Add related keyphrase

Did you know Yoast SEQ Premium also analyzes the different word forms of Go Premium! »
your keyphrase, like plurals and past tenses?

Analysis results

~  Problems (1)

@ Keyphrase in introduction: Your keyphrase or its synonyms do not appear in the first paragraph. Make sure the topic is clear immediately.

~  |Improvements (2}

@ Image alt attributes: Out of 19 images on this page, only 4 have alt attributes that reflect the topic of your text. Add your keyphrase or
synonyms to the alt tags of more relevant images!

¥
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=
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=
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=
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(=]
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=
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Internal links: You have enough internal links. Good job!
Keyphrase length: Good job!
Keyphrase density: The focus keyphrase was found 18 times. This is great! @&

Keyphrase in meta description: Keyphrase or synonym appear in the meta description. Well done!

Meta description length: Well done!

Previously used keyphrase: You've not used this keyphrase before, very good.
Keyphrase in subheading: 5 of your higher-level subheadings reflect the topic of your copy. Good job!

Text length: The text contains 1930 words. Good jobl

® ¢ @ ¢ ¢ & & @ o

U

Keaunhraca in elitn- Crast skl

5.6 - Going Live

In this lesson we'll walk through a final site review and I'll show you how to take down
your coming soon page and submit your sitemap to Google!

Go Live Checklist

Watch the video.

Do a final site review + check every page and every link.
Test your email optin form + freebie delivery.

Turn off your Coming Soon page.

Turn off "Discourage Search Engines" in Settings

OO~ ON —
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Change Search Engine Settings in Yoast to "Site is Live and Ready to be indexed"
Submit Sitemap to Google via Google Search Console.

Turn off maintenance ertor Ttors B 0+ New View Tempiate  Cacring JORNGRSRRRNRN >
mode (Bluehost Only) : Ediit Ternplate | Advew

by going to Settings >
General

And Theﬂ on “LOUﬂCh T 1 Pemenir T 80+ e g N
Your Site” T iif bluehost

Or you can go to
Settings > General,
scroll down to the a : Endtaance Cache

bottom of the list of e L
settings and choose . -

Off and Save your N
changes. wa s

BluehostCaming Soan Page

Weh Starty Cn

Blushast Auta Update Managar

Copyright 2020 | WP+BFF LLC | All Rights Reserved

245




S5+DAY WEBSITE CHALLENGE

Then go into Settings >
Reading and uncheck
“Disable Search
Engines”

Bluehost Reading S&ttlngS

# Dast

Your hemepage displays

Pages
Comments

Appes
Blog pages show at most

Plugins @

Users Syndication feeds show the

most recent
Tools

Settings

For each article in a feed,
show

Search Engine Visibility |

#§ Free 5 Day Website Challange &1 + New @l caching sl Insights  UpdraftPlus

Your latest posts

= A static page (select balow)

Homepage: Home

an

a»

Posts page: Blog

10 paosts

10 items

» Full text

Summary

—

X
Duscg‘.:rage search engines from indexing this site

% 7
\"‘x.ﬂ,gs.-'J:"fG search engines to homnor this reguest.
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Submit sitemap to
Google (Yoast >
General > Features >
XML Sitemaps > See
the XML Sitemap

General - Yoast SEO

Dashboard ¢ Features ) Webmaster Taols

1
(7] NEEEJJ.HELP?{ ~
/

1 Media Featum'._‘g/

P Yoast SE,D comes with a lot of features. You can enable / disable some of them below. Clicking the

qur:st:r}(". mark gives more information about the feature.

SEO/énaIyEis [ 7]

Comments

v Plugins (1 r‘, |
/ Readability analysi [7]
Users I
|
T Settings ; Comerstone conteft @

Text link counter  [E)

i
xmLsaema;g: 0 / —‘———__________:h_ N

— —— .
Enable the XML sitemaps that Yoast SEQ generatestSge the XML sitemag, Read why XML

Sitemaps are important for your site. —

oft

Ryte integration &

allenge &1 B + new B4 caching  ail insights  UpdraftPius

Copy this final part of
the link to your
sitemap:

) - h'ttps.,.'-'scartettmattern_com_gitemap_index.xrnl|

————
! Apps [ Growth University B9 PT45H @ Google Drive [ Courses Site Shor.. [ FB Group Links

XML Sitemap

i

B3 FE Promo

Generated by YoastSED, this is an XML Sitemap, meant for consumption by search engines.

You can find mare information aboul XML siternaps on sitemaps.arg.

This XML Siternap Index file contains 2 sitemaps

Sitemap Last Moditied

hitps: .com/past-sit xml

hitps: ifscarstmatiam comipage-s

2018-07-19 1340 -04:00

{
L
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Log into Google
Search Console (the

account was created
for you when you set
up Site Kit) and click on
Sitemaps. Paste the
partial link you just
copied into the “Add a
New Sitemap” field
and click Submit:

= (Google SearchConsole £ i ey LA LTt P

s o Silemaps

Add a new sitemap

Submitted sitemans =

Yours might say “Couldn’t Fetch” or “Processing” and
that's okay - don’t worry about it - it’ll eventually check
again on it’'s own and say “success”

5.7 - What's Next
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Bonus Printables

On the next few pages you'll find printable frackers, checklists + cheatsheets to
help you keep track of all the things!
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Keyboard Shortcut Cheatsheet

If you're on a Mac, use the Command key instead of Control

Copy: Highlight text, Control + C
Paste: Put cursor where you want to paste, Control + V
Select All: Control + A (or triple click)

Open Link in a New Browser Tab: Conftrol + click
Open a New Blank Browser Tab: Control + N
Refresh browser window: Conftrol + R
Refresh + clear cache: Control + Shiff + R
Create a Link: Highlight text, then Control + K
Bold: Highlight text, then Control + B
Italics: Highlight text, then Control + |

Find text on any document or webpage: Conftrol + F and type
keyword in the finder field, hit enter
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5 Day Website Challenge Dashboard (courses.shannonmatter.com)

Username

Password

Domain/Hosting/Email

Company Name

Website Link

Username

Password

Hosting:

Domain (if different):

Business Email Address:

Your WordPress Site

Login Link

Username

Password

/wp-login.php

Canva (www.canva.com)

Username

Password
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Google Account:
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Username Password
ConveriKit
Username Password

Other Passwords

Account Name

Username

Password
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Brand Tracker

Colors

S5+DAY WEBSITE CHALLENGE

Fonts

Headings

Paragraph Text

Accent
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Blog Post Checklist

Print this checklist every time you write + publish a blog post!

Create Featured Image (Canva - square, pinterest or landscape, dimensions
depend on your theme/design)

Add alt text to Featured Image on upload

Keyword/Phrase:

Title:

Write Content (~800-1000 words)

Chunk text (no more than é lines per paragraph)

Add scannable headers with keywords

Include images in the body of the post to break up text

Categories:

Tags:

Publish Date:
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Website Maintenance: WordPress, Theme + Plugin Updates

Any time you see an
orange dot with a
number in it by the
Plugins menu item,
that means a plugin
needs updated.

#4 Free 5 Day Website Challenge Divi Editio...

@ Dashboard Pages Add New

;'& Posts All (11) | Published (8) |
07 Media Bulk Actions ]
M Pages Title

All Pages About

Add New

® Comments Title

# Projects Bulk Actions A

¥ Appearance

£ Plugins (3

To update any
plugins that have
updates, go to
plugins and click on
the update link:

n D

12718

Image Widget
Oaactivats and mers

Oficial MailerLite Sign Up Forms
Daactivake Varsion 1.1 | By Mal

S0 Oplemizer MordPress apgl

Deactivate

Thits plugin will |

Varsion 51.3 | By SitaGround | Viow

& Plgns 3

o0 There is 8 rew version of 56 Cprimizer suallabie. View weralon 52,0 getail ¢

Installed Plugine

A simpks image wid gat that uses tha native WordPress madis managar ta add image widgets to your sita. image W

Vorsion 4 4.7 | By Momern Triba, ing. | Viow oetal

Ttficial e 1R Sign Up FOrms pugin far WerdPress. Abillty ta smibad Mallsr.Jte wetifanms and craste custam |

e Wikgat Pius

ancs eptizations prosided by SdeGround
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Weekly Maintenance
Checklist:

Go to Dashboard >
Updates and update
anything that needs
updated.

Review WordFence
scans in WordFence >
Scan. it might look
scary if WordFence
finds stuff, | promise
it's not - WF will give
you options to repair
files, delete files, etc.
Just click whatever
button on the option
it's recommending. If
it's a plugin update,
just update the
plugin. No biggie!!

A Help
v v v v v

Biweaba Check s

st Fousd {1

Past, Comemmms, & Fie

The Plugen "Biamenini” naads 8 upgrade (2911 -+ 2092}

Iess Found June 14; 2020 10064 am
Tape Phgin Ugsgrads Shertiam

Whesher yo

CLEAN MY HACKED GITE

P’ Munage soan options incuding schedsling

g Scan Options and Scheduling

v v

FuiveodTrength Vil S
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Monthly Maintenance
Checklist

1. All of the
above.

2. Make sure
backups are
running in
Updraft Plus

 Sottings
Last log message:

The basckug apponently sacoseded o b n

Existing backups )

Mare tasks: Lipin i Gackup (ks | Bescen b

Backup dat

(" aun13, 2000 1a:3s
&
Jun 12, 2020 1507
[

m | hewes | T San-uo | EAG o
Dockew [Restore | bigraie (Clone  Seltings | Advanced Tools  Premium | Uxtannions
Next schedubed backups:
Files; Database:

ow complete Lun 13 14:34:43)

al Eciul Fof B Duack U 5013 | FES0AN (MOLR Shoiwoe

Backup dats (=ick o download) Actians

Annual Maintenance
Checklist

https://shannonmattern.com/steal-2018-website-checklist/
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